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NOTES

(1) The contents of this user’s manual may not be reprinted in part or whole without permission.

(2) The contents of this user’s manual are subject to change without notice.

(3) Great care has been taken in the preparation of this user’s manual; however, should you notice any questionable
points, errors or omissions, please contact us.
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Important Information
Safety Cautions
Precautions
Please read this manual carefully before using your NEC VT695/VT595/VT590/VT491/VT59/VT49 projector and keep
the manual handy for future reference. Your serial number is located on the bottom of your projector. Record it here:

CAUTION
To turn off main power, be sure to remove the plug from power outlet.
The power outlet socket should be installed as near to the equipment as possible, and should be easily
accessible.

CAUTION
TO PREVENT SHOCK, DO NOT OPEN THE CABINET.
THERE ARE HIGH-VOLTAGE COMPONENTS INSIDE.
REFER SERVICING TO QUALIFIED SERVICE PERSONNEL.

This symbol warns the user that uninsulated voltage within the unit may be sufficient to cause electrical
shock. Therefore, it is dangerous to make any kind of contact with any part inside of the unit.

This symbol alerts the user that important information concerning the operation and maintenance of this
unit has been provided.
The information should be read carefully to avoid problems.

WARNING: TO PREVENT FIRE OR SHOCK, DO NOT EXPOSE THIS UNIT TO RAIN OR MOISTURE.
DO NOT USE THIS UNIT’S PLUG WITH AN EXTENSION CORD OR IN AN OUTLET UNLESS ALL THE PRONGS
CAN BE FULLY INSERTED.

DOC Compliance Notice (for Canada only)
This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Regulations.

Machine Noise Information Regulation - 3. GPSGV,
The highest sound pressure level is less than 70 dB (A) in accordance with EN ISO 7779.

CAUTION
Avoid displaying stationary images for a prolonged period of time.

Doing so can result in these images being temporarily sustained on the surface of the LCD panel.

If this should happen, continue to use your projector. The static background from previous images will
disappear.

Disposing of your used product
EU-wide legislation as implemented in each Member State requires that used electrical and electronic
products carrying the mark (left) must be disposed of separately from normal household waste. This
includes projectors and their electrical accessories or lamps. When you dispose of such products, please
follow the guidance of your local authority and/or ask the shop where you purchased the product.
After collecting the used products, they are reused and recycled in a proper way. This effort will help us
reduce the wastes as well as the negative impact such as mercury contained in a lamp to the human
health and the environment at the minimum level.
The mark on the electrical and electronic products only applies to the current European Union Member
States.
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WARNING TO CALIFORNIA RESIDENTS:
Handling the cables supplied with this product will expose you to lead, a chemical known to the State of California
to cause birth defects or other reproductive harm. WASH HANDS AFTER HANDLING.

RF Interference (for USA only)

WARNING
The Federal Communications Commission does not allow any modifications or changes to the unit EXCEPT those
specified by NEC Display Solutions of America, Inc. in this manual. Failure to comply with this government regula-
tion could void your right to operate this equipment. This equipment has been tested and found to comply with the
limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference in a residential installation. This equipment generates, uses,
and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may
cause harmful interference to radio communications. However, there is no guarantee that interference will not
occur in a particular installation.
If this equipment does cause harmful interference to radio or television reception, which can be determined by
turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the
following measures:

• Reorient or relocate the receiving antenna.

• Increase the separation between the equipment and receiver.

• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

• Consult the dealer or an experienced radio / TV technician for help.

For UK only: In UK, a BS approved power cable with moulded plug has a Black (five Amps) fuse installed for use with
this equipment. If a power cable is not supplied with this equipment please contact your supplier.

Important Safeguards
These safety instructions are to ensure the long life of your projector and to prevent fire and shock. Please read them
carefully and heed all warnings.

Installation

• Do not place the projector in the following conditions:

- on an unstable cart, stand, or table.

- near water, baths, or damp rooms.

- in direct sunlight, near heaters, or heat radiating appliances.

- in a dusty, smoky or steamy environment.

- on a sheet of paper or cloth, rugs or carpets.

• If you wish to have the projector installed on the ceiling:

- Do not attempt to install the projector yourself.

- The projector must be installed by qualified technicians in order to ensure proper operation and reduce the
risk of bodily injury.

- In addition, the ceiling must be strong enough to support the projector and the installation must be in accor-
dance with any local building codes.

- Please consult your dealer for more information.
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Fire and Shock Precautions
• Ensure that there is sufficient ventilation and that vents are unobstructed to prevent the build-up of heat inside your

projector. Allow at least 4 inches (10cm) of space between your projector and a wall.
• Do not try to touch the ventilation outlet on the left front (when seen from the front) as it can become heated while

the projector is turned on and immediately after the projector is turned off.
• Prevent foreign objects such as paper clips and bits of paper from falling into your projector. Do not attempt to

retrieve any objects that might fall into your projector. Do not insert any metal objects such as a wire or screwdriver
into your projector. If something should fall into your projector, disconnect it immediately and have the object removed
by a qualified service personnel.

• Do not place any objects on top of the projector.
• Do not touch the power plug during a thunderstorm. Doing so can cause electrical shock or fire.
• The projector is designed to operate on a power supply of 100-240V AC 50/60 Hz. Ensure that your power supply

fits this requirement before attempting to use your projector.
• Do not look into the lens while the projector is on. Serious damage to your eyes could result.
• Keep any items such as magnifying glass out of the light path of the projector. The light being projected from the

lens is extensive, therefore any kind of abnormal objects that can redirect light coming out of the lens, can cause
unpredictable outcome such as fire or injury to the eyes.

• Do not cover the lens with the black lens cap or equivalent while the projector is on. Doing so can lead to melting of
the cap and possibly burning your hands due to the heat emitted from the light output.

• Do not place any objects, which are easily affected by heat, in front of the projector lens or a projector exhaust vent.
Doing so could lead to the object melting or getting your hands burned from the heat that is emitted from the light
output and exhaust.

• Handle the power cable carefully. A damaged or frayed power cable can cause electric shock or fire.
- Do not use any power cables than the supplied one.
- Do not bend or tug the power cable excessively.
- Do not place the power cable under the projector, or any heavy object.
- Do not cover the power cable with other soft materials such as rugs.
- Do not heat the power cable.
- Do not handle the power plug with wet hands.

• Turn off the projector, unplug the power cable and have the projector serviced by a qualified service personnel
under the following conditions:
- When the power cable or plug is damaged or frayed.
- If liquid has been spilled into the projector, or if it has been exposed to rain or water.
- If the projector does not operate normally when you follow the instructions described in this user's manual.
- If the projector has been dropped or the cabinet has been damaged.
- If the projector exhibits a distinct change in performance, indicating a need for service.

• Disconnect the power cable and any other cables before carrying the projector.
• Turn off the projector and unplug the power cable before cleaning the cabinet or replacing the lamp.
• Turn off the projector and unplug the power cable if the projector is not to be used for an extended period of time.

Place the projector in a horizontal position
The tilt angle of the projector should not exceed 10 degrees, nor should the projector be installed in any way other
than the desktop and ceiling mount, otherwise lamp life could decrease dramatically.

10° 
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CAUTION
• Do not use the tilt-foot for purposes other than originally intended. Misuses such as gripping the tilt-foot or

hanging on the wall can cause damage to the projector.

• Do not send the projector in the soft case by parcel delivery service or cargo shipment. The projector inside
the soft case could be damaged.

• When carrying the projector by the carrying handle, make sure the two screws that attach the carrying handle
to the projector cabinet are tight.

Insufficient tightening of the two screws could result in the projector falling and causing injury.

• Select [High] in Fan mode if you continue to use the projector for consecutive days. (From the menu, select
[Setup] → [Options] → [Fan Mode] → [High].)

• Do not turn off the AC power by pressing the main power switch or by unplugging the power cable when the
projector is powered on.

• Do not turn off the AC power for 60 seconds after the lamp is turned on and while the POWER indicator is blinking
green. Doing so could cause premature lamp failure.

Remote Control Precautions

• Handle the remote control carefully.

• If the remote control gets wet, wipe it dry immediately.

• Avoid excessive heat and humidity.

• Do not heat, take apart, or throw batteries into fire.

• If you will not be using the remote control for a long time, remove the batteries.

• Ensure that you have the batteries’ polarity (+/-) aligned correctly.

• Do not use new and old batteries together, or use different types of batteries together.

• Dispose of used batteries according to your local regulations.

Lamp Replacement

• To replace the lamp, follow all instructions provided on page 52.

• Be sure to replace the lamp when the message [The lamp has reached the end of its usable life. Please
replace the lamp.] appears. If you continue to use the lamp after the lamp has reached the end of its usable
life, the lamp bulb may shatter, and pieces of glass may be scattered in the lamp case. Do not touch them as
the pieces of glass may cause injury.

If this happens, contact your dealer for lamp replacement.

A Lamp Characteristic
The projector has a high-pressure mercury lamp as a light source.
A lamp has a characteristic that its brightness gradually decreases with age. Also repeatedly turning the lamp on
and off will increase the possibility of its lower brightness.

CAUTION:

When removing the lamp from a ceiling-mounted projector, make sure that no one is under the projector. Glass
fragments could fall if the lamp has been burned out.

Important Information
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Projector

Lens cap
(24FT9641)

Power cable
(US: 7N080220)
(EU: 7N080015)

VGA signal cable
(7N520052)

Soft case
(24BS7582)

CD-ROM
User’s manual

For North America only
Registration card
Limited warranty

For Europe only
Guarantee policyQuick Setup Guide
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1. Introduction

For VT695, VT595, VT590
and VT491 only

VOLUME

S-VIDEO

VIDEO

L-CLICK

ENTER

EXIT

MENU UP

MAGNIFY

PAGE

OFF

POWER ON
PIC-MUTE

DOWN

MOUSE R-CLICKAUTO ADJ.LAMP MODE

COMPUTER

ASPECT
HELP

FREEZE

PICTURE

1
2

Remote control
(7N900731)

Batteries (AAA�2)

Carrying handle (24FT9651)
Screw (M4�2: 24V00411)

� What's in the Box?
Make sure your box contains everything listed. If any pieces are missing, contact your dealer.
Please save the original box and packing materials if you ever need to ship your projector.

For VT695 and VT595 only

DVI to VGA adapter (7N960231)
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� Introduction to the Projector
This section introduces you to your new projector and describes the features and controls.

Congratulations on Your Purchase of the Projector
This projector is one of the very best projectors available today. The projector enables you to project precise images
up to 300 inches across (measured diagonally) from your PC or Macintosh computer (desktop or notebook), VCR,
DVD player, document camera, or a laser disc player.
You can use the projector on a tabletop or cart, you can use the projector to project images from behind the screen,
and the projector can be permanently mounted on a ceiling*1. The remote control can be used wirelessly.

*1 Do not attempt to mount the projector on a ceiling yourself.

The projector must be installed by qualified technicians in order to ensure proper operation and reduce the
risk of bodily injury.

In addition, the ceiling must be strong enough to support the projector and the installation must be in accor-
dance with any local building codes. Please consult your dealer for more information.

Features you'll enjoy:
• Auto vertical keystone correction up to +/– 30 degrees (VT695 and VT595 only)

• Built-in Wall Color Correction presets provide for adaptive color correction when projecting onto non-white
screen material

• Quick start & quick cool down

Eight seconds after turning on the power, the projector is ready to display PC or video images.

Powering down; The fans stop 30 seconds after turning off the power from the remote control or cabinet control
panel. The projector can be put away immediately after the projector is powered down.

Also, the main power of the projector can be turned off by pressing the main power switch or unplugging the
power cable even during the cool down period after the projector is turned off.

• DVI input connector (DVI-I 29 Pin) with HDCP compatible (VT695 and VT595 only)

• HDTV (1080i, 720p) and SDTV (576p, 480p) compatibility

• Color Management system

• Short focal length lens

• Display popular wide screen and full screen aspect ratios – 16:9 and 4:3

• Built-in speaker for an integrated audio solution

• High resolution display - up to UXGA compatible, XGA native resolution (SVGA: VT491 and VT49).

• Multiple video mode selections (depending on your source)

• Security feature prevents unauthorized individuals from displaying images.

• You can control the projector with a PC or control system using the PC Control port.

• Easy set up and operation

• The contemporary cabinet design is light, compact and complements any office, boardroom Auditorium.

• You can use the supplied wireless remote control and the optional remote mouse receiver to operate your PC
mouse  from across the room. The optional remote mouse receiver (NP01MR) supports almost any PC using a
USB connection.

About this user's manual
The fastest way to get started is to take your time and do everything right the first time. Take a few minutes now to
review the user's manual. This may save you time later on. At the beginning of each section of the manual you'll find
an overview. If the section doesn't apply, you can skip it.
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� Part Names of the Projector
Front/Top

FOCUS

MENU

SELECT
LAMPSTATUSPOWER

ON/STAND BY SOURCE
AUTO ADJ.

E
N

T
E

R

EXIT

ZOOM

Zoom Lever (VT695/VT595/VT590/VT491/VT59)
Digital Zoom Button (VT49)

(→ page 24)

Controls
(→ page 5)

Lens

Lens Cap

Built-in Security Slot (  )*

Focus Ring
(→ page 24)

Remote sensor
(→ page 8)

Ventilation (inlet) / Filter Cover
(→ page 50)
Two filters on VT695, VT595, VT590
and VT491
One filter on VT59 and VT49

AC Input
Connect the supplied power cable's two-pin plug here, and
plug the other end into an active wall outlet. (→ page 19)

Main Power Switch
When you plug the supplied power cable into an active wall outlet
and turn on the Main Power, the POWER indicator turns orange
and the projector is in standby mode.
(→ page 20,28)

Remote sensor
(VT695, VT595 and VT491 only)
(→ page 8)

Terminal Panel
(→ page 6)

Monaural Speaker
(VT695/VT595: 5W)

(VT590/VT491/VT59/VT49: 1W)

* This security slot supports the MicroSaver ® Security System. MicroSaver ® is a registered trademark of
Kensington Microware Inc. The logo is trademarked and owned by Kensington Microware Inc.

Ventilation (outlet)
Heated air is exhausted from here.

Rear

FOCUS

ZOOM
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Adjustable Tilt Foot
(→ page 23)

Rear Foot (Left / Right)
(→ page 23)

Adjustable Tilt Foot Button
(→ page 23)

Lamp Cover
(→ page 52)

Carrying handle

Screw

Phillips-head screwdriver
(not supplied)

Attaching the supplied carrying handle (VT695, VT595, VT590 and VT491 only)
You can carry the projector by attaching the supplied carrying handle securely to the projector.
To attach the supplied carrying handle, use a Phillips-head screwdriver and the supplied two screws.
Place a soft cloth on the working surface before turning the projector over to prevent scratching the top cover.
Make sure that the carrying handle is attached with correct orientation as shown below.

CAUTION
When carrying the projector by the carrying handle, make sure the two screws that attach the carrying handle
to the projector cabinet are tight.

Bottom



5

1. Introduction

Top Features

SELECT

MENU

ENTER EXITLAMP

STATUS

POWER

ON/STAND BY AUTO ADJ.SOURCE

4

78

3

1

2
9

10

5 6

1. LAMP Indicator (→page 52,55)

2. STATUS Indicator (→page 55)

3. POWER Indicator (→page 20,28,55)

4. POWER Button (ON / STAND BY) ( )
(→page 20,28)

5. SOURCE Button (→page 22)

6. AUTO ADJ. Button (→page 27)

7. MENU Button (→page 36)

8. SELECT ���� / Volume Buttons �� /
Keystone Buttons �� (→page 25,27)

9. ENTER Button

10. EXIT Button
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AUDIO OUT

AUDIO IN

MONITOR OUT (COMP 1)

COMPUTER 1 INCOMPUTER 2 (DVI-I) IN

AUDIO IN

S-VIDEO
IN

VIDEO IN

PC CTRLL

R

L COMPUTER INMONITOR  OUT

AUDIO INVIDEO IN

PC CONTROL

R

S-VIDEO
IN

AUDIO OUT

AUDIO IN

COMPUTER 2 IN

COMPUTER 1 INMONITOR  OUT(COMP 1)

AUDIO IN

S-VIDEO
IN

VIDEO IN

PC CONTROLL

R

1985 2

3 476

76

1485

1485 2

3 1076

Terminal Panel Features

1. COMPUTER 1 IN/ Component Input Connector
(Mini D-Sub 15 Pin)
(VT695/VT595/VT491) (→page 13,15)

COMPUTER IN/ Component Input Connector
(Mini D-Sub 15 Pin)
(VT590/VT59/VT49) (→page 13,17)

2. AUDIO IN Mini Jack (Stereo Mini) (→page 13,14,17)
(VT695/VT595/VT491)

3. AUDIO OUT Mini Jack (Stereo Mini) (→page 16)
(VT695/VT595/VT491)

4. MONITOR OUT Connector (Mini D-Sub 15 Pin)
(→page 16)

5. S-VIDEO IN Connector (Mini DIN 4 Pin)
(→page 18)

6. VIDEO IN Connector (RCA) (→page 18)

7. AUDIO Input Jacks L/R (RCA) (→page 13,17,18)

8. PC CONTROL Port (DIN 8 Pin) (→page 64,65)
Use this port to connect a PC or control system.
This enables you to control the projector using serial
communication protocol. If you are writing your own
program, typical PC control codes are on page 64.

9. COMPUTER 2 (DVI-I) IN (DVI-I 29 Pin) (→page 14,15)
(VT695/VT595)

10. COMPUTER 2 IN / Component Input Connector
(Mini D-Sub 15 Pin) (→page 13,16)
(VT491)

VT590/VT59/VT49

VT695/VT595

VT491
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� Part Names of the Remote Control

1. Infrared Transmitter
(→ page 8)

2. POWER ON Button
(→ page 20)

3. POWER OFF Button
(→ page 28)

4. MAGNIFY (+)(–) Button
(→ page 30)

5. PIC-MUTE Button
(→ page 30)

6. PAGE UP/DOWN Button*
(→ page 34,35)

7. MENU Button
(→ page 36)

8. SELECT ���� Button

9. ENTER Button

10. EXIT Button

11. MOUSE L-CLICK Button*
(→ page 34,35)

VOLUME

L-CLICK

ENTER EXIT

MENU

UP

MAGNIFY PAGE

OFF

POWER

ON

PIC-MUTE

DOWN

MOUSE

R-CLICK

COMPUTER

ASPECT HELP

FREEZEPICTURE

S-VIDEO

VIDEO COMPUTER AUTO ADJ.

LAMP MODE

2

1

1

3

4

7

6

9

2

8

10

11

13

14

12

21

22
20

16
15
18

5

17
19

12. MOUSE R-CLICK Button*
(→ page 34,35)

13. VIDEO Button
(→ page 22)

14. S-VIDEO Button
(→ page 22)

15. COMPUTER 1/2 Button
(The COMPUTER 2 button is not available on
VT590, VT59 and VT49)
(→ page 22)

16. AUTO ADJ. Button
(→ page 27)

17. VOLUME (+)(–) Button
(→ page 27)

18. LAMP MODE Button (→ page 31)

19. ASPECT Button
(→ page 42)

20. PICTURE Button
(→ page 41,42)

21. HELP Button
(→ page 48)

22. FREEZE Button
(→ page 30)

* The PAGE UP/DOWN, MOUSE L-CLICK and MOUSE R-CLICK buttons work only when the optional remote mouse
receiver is connected with your computer.
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Remote Control Precautions
• Handle the remote control carefully.
• If the remote control gets wet, wipe it dry immediately.
• Avoid excessive heat and humidity.
• Do not heat, take apart, or throw batteries into fire.
• If you will not be using the remote control for a long time, remove the batteries.
• Ensure that you have the batteries’ polarity (+/-) aligned correctly.
• Do not use new and old batteries together, or use different types of batteries together.
• Dispose of used batteries according to your local regulations.

Operating Range for Wireless Remote Control

1 Press firmly and slide the
battery cover off.

2 Install new batteries (AAA).
Ensure that you have the
batteries' polarity (+/–) aligned
correctly.

3 Slip the cover back over the bat-
teries until it snaps into place. Do
not mix different types of batter-
ies or new and old batteries.

• The infrared signal operates by line-of-sight up to a distance of about 22 feet/7 m and within a 60-degree angle of
the remote sensor on the projector cabinet.

• The projector will not respond if there are objects between the remote control and the sensor, or if strong light falls
on the sensor. Weak batteries will also prevent the remote control from properly operating the projector.

M
E

N
U

S
E

LE
C

T

EXIT

ENTER

LA
M

P

ST
AT

U
S

PO
W

ER

O
N

/S
TA

N
D

 B
Y

AU
TO

 A
D

J.
SO

U
R

C
E

30°

(*) 30°

30°

30°

FO
C

U
S

ZO
O

M

*NOTE: The VT590, VT59 and VT49 do not have the
remote sensor on the rear panel.

Battery Installation

7m/22feet

7m/22feet

Remote control
Remote sensor on projector cabinet
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2. Installation and Connections

FOCUS

MENU

SELECT
LAMPSTATUSPOWER

ON/STAND BY SOURCE
AUTO ADJ.

E
N

TE
R

EXIT

ZOOM

This section describes how to set up your projector and how to connect video and audio sources.
Your projector is simple to set up and use. But before you get started, you must first:

1 Set up a screen and the projector.

2 Connect your computer or video equipment
to the projector.
(→ page 13,14,15,16,17,18)

3 Connect the supplied power cable.
(→ page 19)

NOTE: Ensure that the power cable and any
other cables are disconnected before moving
the projector. When moving the projector or
when it is not in use, cover the lens with the
lens cap.

� Setting Up the Screen and the Projector
Selecting a Location (VT695)
The further your projector is from the screen or wall, the larger the image. The minimum size the image can be is
approximately 21" (0.53 m) measured diagonally when the projector is roughly 38 inches (1.0 m) from the wall or
screen. The largest the image can be is 300" (7.6 m) when the projector is about 389 inches (9.9 m) from the wall or
screen.

300"

240"

200"
180"

150"
120"

100"

60"
40"30"21"

80"

Distance (U
nit: m

/inch)

Screen Size (Unit: cm/inch)

Screen Size

Lens center

609.6(W)�457.2(H) / 240(W)�180(H)

487.7(W)�365.8(H) / 192(W)�144(H)

406.4(W)�304.8(H) / 160(W)�120(H)

365.8(W)�274.3(H) / 144(W)�108(H)

304.8(W)�228.6(H) / 120(W)�90(H)

243.8(W)�182.9(H) / 96(W)�72(H)

203.2(W)�152.4(H) / 80(W)�60(H)

162.6(W)�121.9(H) / 64(W)�48(H)

121.9(W)�91.4(H) / 48(W)�36(H)

81.3(W)�61.0(H) / 32(W)�24(H)

61.0(W)�45.7(H) / 24(W)�18(H)

42.7(W)�32(H) / 17(W)�13(H)

1.0/380.7/
29

2.0/77
2.6/103

3.3/129
3.9/155 4.9/194 5.9/233

6.6/259 7.9/311
9.9/389

1.3/
51

FOCUS

MENU

SELECT
LAMPSTATUSPOWER

ON/STAND BY SOURCE AUTO ADJ.

ENTER

EXIT

ZOOM

TIP:
• The distances are indicated by intermediate values between tele and wide. Use as a rule of thumb.
• The Zoom lever adjusts the image size +/-10%
• For more details on throw distance, see page 11.

To the wall outlet.
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Selecting a Location (VT595/VT590/VT491/VT59)
The further your projector is from the screen or wall, the larger the image. The minimum size the image can be is
approximately 21" (0.53 m) measured diagonally when the projector is roughly 30 inches (0.8 m) from the wall or screen.
The largest the image can be is 300" (7.6 m) when the projector is about 400 inches (10 m) from the wall or screen.

300"

240"

200"
180"

150"
120"

100"

60"
40"30"21"

80"

Distance (U
nit: m

/inch)

Screen Size (Unit: cm/inch)

Screen Size

Lens center

609.6(W)�457.2(H) / 240(W)�180(H)

487.7(W)�365.8(H) / 192(W)�144(H)

406.4(W)�304.8(H) / 160(W)�120(H)

365.8(W)�274.3(H) / 144(W)�108(H)

304.8(W)�228.6(H) / 120(W)�90(H)

243.8(W)�182.9(H) / 96(W)�72(H)

203.2(W)�152.4(H) / 80(W)�60(H)

162.6(W)�121.9(H) / 64(W)�48(H)

121.9(W)�91.4(H) / 48(W)�36(H)

81.3(W)�61.0(H) / 32(W)�24(H)

61.0(W)�45.7(H) / 24(W)�18(H)

42.7(W)�32(H) / 17(W)�13(H)

1.0/390.8/
30

2.0/80
2.7/106

3.4/133
4.1/160 5.1/200 6.1/240

6.8/267 8.1/321
10.2/402

1.3/
53

FOCUS

MENU

SELECT
LAMPSTATUSPOWER

ON/STAND BY SOURCE AUTO ADJ.

ENTER

EXIT

ZOOM

TIP:
• The distances are indicated by intermediate values between tele and wide. Use as a rule of thumb.
• The Zoom lever adjusts the image size +/-10%
• For more details on throw distance, see page 11.

Selecting a Location (VT49)
The further your projector is from the screen or wall, the larger the image. The minimum size the image can be is
approximately 25" (0.64 m) measured diagonally when the projector is roughly 35 inches (0.9 m) from the wall or
screen. The largest the image can be is 300" (7.6 m) when the projector is about 434 inches (11.0 m) from the wall or
screen. Use the drawing below as a guide.

25"

300"

240"

200"180"

150"
120"100"

60"
40"

80"

Distance (U
nit: m

/inch)

Lens center

0.9/
35

1.4/57

2.2/86
2.9/115

3.7/144
4.4/173

5.5/217
6.6/260

7.3/289
8.8/347

11.0/434

Screen Size (Unit: cm/inch)

Screen Size
609.6(W)�457.2(H) / 240(W)�180(H)

487.7(W)�365.8(H) / 192(W)�144(H)

406.4(W)�304.8(H) / 160(W)�120(H)

365.8(W)�274.3(H) / 144(W)�108(H)

304.8(W)�228.6(H) / 120(W)�90(H)

243.8(W)�182.9(H) / 96(W)�72(H)

203.2(W)�152.4(H) / 80(W)�60(H)

162.6(W)�121.9(H) / 64(W)�48(H)

121.9(W)�91.4(H) / 48(W)�36(H)

81.3(W)�61.0(H) / 32(W)�24(H)

50.8(W)�38.1(H) / 20(W)�15(H)

FOCUS

MENU

SELECT
LAMPSTATUSPOWER

ON/STAND BY SOURCE AUTO ADJ.

ENTER

EXIT

ZOOM

TIP:
• The distances are indicated by intermediate values between tele and wide. Use as a rule of thumb.
• Digital Zoom can result in a blurry image due to the electronic zoom.
• The Zoom button adjusts the image size -10%
•  For more details on throw distance, see next page.

2. Installation and Connections



11

2. Installation and Connections

Screen bottom
Projector bottom

C

α

B

D

Lens center

Screen center

Throw Distance and Screen Size
The following shows the proper relative positions of the projector and screen. Refer to the table to determine the
position of installation.

Distance Chart

B = Vertical distance between lens center and
screen center

C = Throw distance
D = Vertical distance between lens center and

screen bottom (top of screen for ceiling
application)

α = Throw angle

NOTE: Distances may vary +/-5%.

VT595/VT590/VT491/VT59

Screen Size C α
BDiagonal

inch
21
25
30
40
60
72
80
84
90

100
120
150
180
200
210
240
270
300

mm
533
635
762

1016
1524
1829
2032
2134
2286
2540
3048
3810
4572
5080
5334
6096
6858
7620

inch
17
20
24
32
48
58
64
67
72
80
96

120
144
160
168
192
216
240

mm
427
508
610
813

1219
1463
1626
1707
1829
2032
2438
3048
3658
4064
4267
4877
5486
6096

inch
13
15
18
24
36
43
48
50
54
60
72
90

108
120
126
144
162
180

mm
320
381
457
610
914

1097
1219
1280
1372
1524
1829
2286
2743
3048
3200
3658
4115
4572

inch
4
5
6
9

13
15
17
18
19
21
26
32
38
43
45
51
57
64

mm
110
140
160
220
320
390
430
450
490
540
650
810
970

1080
1140
1300
1460
1620

D

inch
-2
-2
-3
-3
-5
-6
-7
-7
-8
-9

-10
-13
-16
-17
-18
-21
-24
-26

mm
-50
-60
-70
-90

-130
-160
-180
-190
-200
-220
-270
-330
-400
-440
-460
-530
-600
-660

inch
-
29
35
48
72
87
96

101
109
121
145
182
218
243
255
291
328
365

mm
-
740
900

1210
1830
2200
2450
2570
2760
3070
3690
4620
5540
6160
6470
7400
8330
9260

-
-
-
-
-
-
-
-
-
-
-
-
-
-
-
-
-
-
-

-
-
-
-
-
-
-
-
-
-
-
-
-
-
-
-
-
-
-

inch
30
35
43
57
87

104
116
122
131
145
174
218
262
291
306
350
394
438 

degree
-

10.3
10.2
10.1
10.1
10.0
10.0
10.0
10.0
10.0
10.0
10.0
10.0
10.0
10.0
9.9
9.9
9.9

degree
8.6
8.5
8.5
8.4
8.4
8.4
8.4
8.4
8.4
8.3
8.3
8.3
8.3
8.3
8.3
8.3
8.3
8.3

mm
750
900

1090
1460
2200
2650
2940
3090
3310
3690
4430
5540
6660
7400
7770
8890

10000
11120 

Width Height wide tele wide tele

Screen Size C α
BDiagonal

inch
21
25
30
40
60
72
80
84
90

100
120
150
180
200
210
240
270
300

mm
533
635
762

1016
1524
1829
2032
2134
2286
2540
3048
3810
4572
5080
5334
6096
6858
7620

inch
17
20
24
32
48
58
64
67
72
80
96

120
144
160
168
192
216
240

mm
427
508
610
813

1219
1463
1626
1707
1829
2032
2438
3048
3658
4064
4267
4877
5486
6096

inch
13
15
18
24
36
43
48
50
54
60
72
90

108
120
126
144
162
180

mm
320
381
457
610
914

1097
1219
1280
1372
1524
1829
2286
2743
3048
3200
3658
4115
4572

inch
4
5
6
8

12
15
17
17
19
21
25
31
37
41
43
50
56
62

mm
110
130
160
210
310
380
420
440
470
520
630
790
940

1050
1100
1260
1410
1570

D

inch
-2
-2
-3
-4
-6
-7
-8
-8
-8
-9

-11
-14
-17
-19
-20
-23
-25
-28

mm
-50
-60
-70

-100
-140
-170
-190
-200
-210
-240
-290
-360
-430
-480
-500
-570
-640
-710

inch
-
28
34
46
70
84
93
98

105
117
141
176
211
235
247
282
318
353

mm
-
720
870

1170
1770
2130
2370
2490
2670
2970
3570
4470
5370
5970
6270
7170
8070
8970

-
-
-
-
-
-
-
-
-
-
-
-
-
-
-
-
-
-
-

-
-
-
-
-
-
-
-
-
-
-
-
-
-
-
-
-
-
-

inch
29
34
41
56
84

101
112
118
126
141
169
211
254
282
296
339
381
424

degree
-

10.3
10.2
10.1
10.1
10.0
10.0
10.0
10.0
10.0
10.0
10.0
10.0
10.0
10.0
9.9
9.9
9.9

degree
8.6
8.6
8.5
8.4
8.4
8.4
8.4
8.4
8.4
8.3
8.3
8.3
8.3
8.3
8.3
8.3
8.3
8.3

mm
730
870

1050
1410
2130
2560
2850
2990
3210
3570
4290
5370
6450
7170
7530
8610
9690

10770

Width Height wide tele wide tele

VT695
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2. Installation and Connections

WARNING
* Installing your projector on the ceiling must be done

by a qualified technician. Contact your NEC dealer
for more information.

* Do not attempt to install the projector yourself.
• Only use your projector on a solid, level surface. If the

projector falls to the ground, you can be injured and
the projector severely damaged.

• Do not use the projector where temperatures vary
greatly. The projector must be used at temperatures
between 41˚F (5˚C) and 104˚F (40˚C) (Eco mode
selected automatically at 95˚F to 104˚F/35˚C to 40˚C).

• Do not expose the projector to moisture, dust, or
smoke. This will harm the screen image.

• Ensure that you have adequate ventilation around your
projector so heat can dissipate. Do not cover the vents
on the side or the front of the projector.

Reflecting the Image
Using a mirror to reflect your projector’s image enables
you to enjoy a much larger image when a smaller space
is required. Contact your NEC dealer if you need a mirror
system. If you're using a mirror system and your image
is inverted, use the MENU and SELECT buttons on your
projector cabinet or your remote control to correct the
orientation. (→ page 45)

VT49

Screen Size
αDiagonal

inch
25
30
40
60
72
80
84
90

100
120
150
180
200
210
240
270
300

mm
635
762

1016
1524
1829
2032
2134
2286
2540
3048
3810
4572
5080
5334
6096
6858
7620

inch
20
24
32
48
58
64
67
72
80
96

120
144
160
168
192
216
240

mm
508
610
813

1219
1463
1626
1707
1829
2032
2438
3048
3658
4064
4267
4877
5486
6096

inch
15
18
24
36
43
48
50
54
60
72
90

108
120
126
144
162
180

mm
381
457
610
914

1097
1219
1280
1372
1524
1829
2286
2743
3048
3200
3658
4115
4572

DCB

inch
5
6
9

13
15
17
18
19
21
26
32
38
43
45
51
57
64

mm
140
160
220
320
390
430
450
490
540
650
810
970

1080
1140
1300
1460
1620

inch
35
42
57
86

103
115
121
129
144
173
217
260
289
304
347
391
434

mm
890

1070
1440
2180
2620
2920
3060
3290
3650
4390
5500
6610
7340
7710
8820
9930

11030

inch
-2
-3
-3
-5
-6
-7
-7
-8
-9

-10
-13
-16
-17
-18
-21
-24
-26

mm
-60
-70
-90

-130
-160
-180
-190
-200
-220
-270
-330
-400
-440
-460
-530
-600
-660

degree
8.7
8.6
8.5
8.5
8.4
8.4
8.4
8.4
8.4
8.4
8.4
8.4
8.4
8.4
8.4
8.4
8.4

Width Height
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AUDIO OUT

AUDIO IN

MONITOR OUT (COMP 1)

COMPUTER 1 INCOMPUTER 2 (DVI-I) IN

AUDIO IN

S-VIDEO
IN

VIDEO IN

PC CTRLL

R

COMPUTER 1 IN

AUDIO IN

PHONE

L COMPUTER INMONITOR  OUT

AUDIO IN

S-VIDEO
IN

VIDEO IN

PC CONTROL

R

COMPUTER IN

AUDIO OUT

AUDIO IN

COMPUTER 2 IN

COMPUTER 1 INMONITOR  OUT(COMP 1)

AUDIO IN

S-VIDEO
IN

VIDEO IN

PC CONTROLL

R

COMPUTER 1 IN

COMPUTER 2 IN

R

AUDIO IN

2. Installation and Connections

� Making Connections
NOTE: When using with a notebook PC, be sure to connect the projector and notebook PC while the projector is in standby mode
and before turning on the power to the notebook PC.
In most cases the output signal from the notebook PC is not turned on unless connected to the projector before being powered
up.
* If the screen goes blank while using your remote control, it may be the result of the computer's screen-saver or power

management software.

Enabling the computer’s external display
Displaying an image on the notebook PC’s screen does not necessarily mean it outputs a signal to the projector.
When using a PC compatible laptop, a combination of function keys will enable/disable the external display.
Usually, the combination of the ‘Fn” key along with one of the 12 function keys gets the external display to come on or
off. For example, NEC laptops use Fn + F3, while Dell laptops use Fn + F8 key combinations to toggle through
external display selections.

Connecting Your PC or Macintosh Computer

NOTE: • VT695/VT595/VT491: The COMPUTER 1 connector supports Plug & Play (DDC2).
• VT590/VT59/VT49: The COMPUTER connector supports Plug & Play (DDC2).

IBM VGA or Compatibles (Notebook
type) or Macintosh (Notebook type)

VT590/VT59/VT49VT695/VT595

NOTE: The projector is not compatible with video decoded outputs of the NEC ISS-6020 switcher.

NOTE: An image may not be displayed correctly when a Video or S-Video source is played back via a commercially available scan
converter.
This is because the projector will process a video signal as a computer signal at the default setting. In that case, do the following.
* When an image is displayed with the lower and upper black portion of the screen or a dark image is not displayed correctly:

Project an image to fill the screen and then press the AUTO ADJ. button on the remote control or the projector cabinet.

VGA signal cable (supplied)
To mini D-Sub 15-pin connector on the projector. It is
recommended that you use a commercially available
distribution amplifier if connecting a signal cable longer
than the cable supplied.

NOTE: For older Macintosh, use a commercially available
pin adapter (not supplied) to connect to your Mac's
video port.

Audio cable
(not supplied)

VT491
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2. Installation and Connections

When Viewing a DVI Digital Signal (VT695/VT595)
To project a DVI digital signal, be sure to connect the PC and the projector using a DVI cable (not supplied) before
turning on your PC or projector. Turn on the projector first and select Computer 2 (Digital) from the source menu
before turning on your PC.
Failure to do so may not activate the digital output of the graphics card resulting in no picture being displayed. Should
this happen, restart your PC.
Do not disconnect the DVI cable while the projector is running. If the signal cable has been disconnected and then re-
connected, an image may not be correctly displayed. Should this happen, restart your PC.

NOTE:
• Use a DVI cable or the one compliant with DDWG (Digital Display Working Group) DVI (Digital Visual Interface) revision 1.0

standard. The DVI cable should be within 5 m (196") long. Both single and dual types of DVI cable can be used.
• The DVI (DIGITAL) connector accepts VGA (640x480), SVGA (800x600), 1152x864, XGA (1024x768) and SXGA (1280x1024 @

up to 60Hz).

AUDIO OUT

AUDIO IN

MONITOR OUT (COMP 1)

COMPUTER 1 INCOMPUTER 2 (DVI-I) IN

AUDIO IN

S-VIDEO
IN

VIDEO IN

PC CTRLL

R

AUDIO IN
COMPUTER 2 (DVI-I) IN

PHONE

Audio cable (not supplied)

IBM PC or Compatibles (Desktop type)
or Macintosh (Desktop type)

DVI cable (not supplied)



15

Using Two Analog COMPUTER Inputs Simultaneously (VT695/VT595)
If you need to use two analog COMPUTER inputs simultaneously, connect a VGA signal cable as shown below.

AUDIO OUT

AUDIO IN

MONITOR OUT (COMP 1)

COMPUTER 1 INCOMPUTER 2 (DVI-I) IN

AUDIO IN

S-VIDEO
IN

VIDEO IN

PC CTRLL

R

COMPUTER 1 INCOMPUTER 2 (DVI-I) IN

VGA signal cable
(supplied)

IBM PC or Compatibles (Notebook type)
or Macintosh (Notebook type)

IBM PC or Compatibles (Desktop
type) or Macintosh (Desktop type)

VGA signal cable (not
supplied)

DVI to VGA adapter
(supplied)

2. Installation and Connections

NOTE: When the DVI to VGA adapter is not to be used for an extended period of time, remove it from the projector. Failure to do
so may cause damage to the connector of the projector.
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2. Installation and Connections

Connecting an External Monitor

You can connect a separate, external monitor to your projector to simultaneously view on a monitor the RGB analog
image you're projecting.

NOTE:
• Daisy chain connection is not possible.
• The signal from the COMPUTER 2 IN connector cannot be output from the MONITOR OUT connector on VT695/VT595/VT491.
• When the DVI Digital signal is selected, no signals will be output from the MONITOR OUT connector on VT695 and VT595.
• The VT590/VT59/VT49  do not have the AUDIO OUT connector.

AUDIO
IN

AUDIO OUT

AUDIO IN

MONITOR OUT (COMP 1)

COMPUTER 1 INCOMPUTER 2 (DVI-I) IN

AUDIO IN

S-VIDEO
IN

VIDEO IN

PC CTRLL

R

MONITOR OUT 

L COMPUTER INMONITOR  OUT

AUDIO IN

S-VIDEO
IN

VIDEO IN

PC CONTROL

R

MONITOR OUT

AUDIO OUT 

AUDIO OUT

AUDIO IN

COMPUTER 2 IN

COMPUTER 1 INMONITOR  OUT(COMP 1)

AUDIO IN

S-VIDEO
IN

VIDEO IN

PC CONTROLL

RR

MONITOR OUT

VGA signal cable (supplied)

VGA signal cable (not supplied)

VT695/VT595 VT491

VT590/VT59/VT49
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2. Installation and Connections

Connecting Your DVD Player with Component Output

A component signal will be automatically displayed. If not, from the menu, select [Setup] → [Options] → [Signal
Select] → [Computer 1 ([Computer] on VT590/VT59/VT49)], and then place a check mark in the Component radio
button.

NOTE: Refer to your DVD player's owner's manual for more information about your DVD player's video output requirements.

AUDIO IN
L R

AUDIO OUT

L R

Component

Y Cb Cr

AUDIO OUT

AUDIO IN

MONITOR OUT (COMP 1)

COMPUTER 1 INCOMPUTER 2 (DVI-I) IN

AUDIO IN

S-VIDEO
IN

VIDEO IN

PC CTRLL

R

COMPUTER 1 INAUDIO IN

COMPUTER INMONITOR  OUT

COMPUTER IN
PC CONTROL

R
AUDIO IN

S-VIDEO
IN

VIDEO IN

L

AUDIO IN 

AUDIO OUT

AUDIO IN

COMPUTER 2 IN

COMPUTER 1 INMONITOR  OUT(COMP 1)

AUDIO IN

S-VIDEO
IN

VIDEO IN

PC CONTROLL

RR

COMPUTER 1 IN

AUDIO IN 

DVD player

Audio Equipment

Audio cable (not supplied)

15-pin - to - RCA
(female) �3 cable
adapter (ADP-CV1E)

Component video RCA�3
cable (not supplied)

VT695/VT595

VT590/VT59/VT49

VT491
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2. Installation and Connections

Connecting Your VCR or Laser Disc Player

NOTE: The AUDIO IN L/MONO and R jacks (RCA) are shared between the Video and S-Video inputs.

NOTE: Refer to your VCR or laser disc player owner's manual for more information about your equipment's video output
requirements.

NOTE: An image may not be displayed correctly when a Video or S-Video source is played back in fast-forward or fast-rewind via
a scan converter.

AUDIO IN
L RAUDIO OUT

L R

VIDEO OUT
S-VIDEO VIDEO

AUDIO OUT

AUDIO IN

MONITOR OUT (COMP 1)

COMPUTER 1 INCOMPUTER 2 (DVI-I) IN

AUDIO IN

S-VIDEO
IN

VIDEO IN

PC CTRLL

R

VIDEO IN

S-VIDEO IN AUDIO IN

S-Video cable (not supplied)

Video cable (not supplied)

VCR/ Laser disc player

Audio equipment

Audio cable (not supplied)

The above drawing is for VT695/VT595. The layout
except VIDEO, S-VIDEO and AUDIO connectors
may differ slightly from that shown in this drawing
depending on the model.
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2. Installation and Connections

Connecting the Supplied Power Cable
Connect the supplied power cable to the projector.
First connect the supplied power cable's two-pin plug to the AC IN of the projector, and then connect the other plug of
the supplied power cable in the wall outlet.

CAUTION:

Do not try to touch the ventilation outlet on the left front (when seen from the front) as it can become heated while
the projector is turned on and immediately after the projector is turned off.

CAUTION:

Do not turn off the AC power by pressing the main power switch or by unplugging the power cable when the
projector is powered on. Doing so can cause damage to the projector.

TIP: The projector can be turned off (by either the main power switch or by unplugging the power cable)
during its cool down period after it is turned off using the remote control or via the power button on the control panel.

FOCUS

MENU

SELECT
LAMPSTATUSPOWER

ON/STAND BY SOURCE
AUTO ADJ.

E
N

T
E

R

EXIT

ZOOM

Make sure that the prongs are fully inserted into both
the AC IN and the wall outlet.

To wall outlet ←
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3. Projecting an Image (Basic Operation)

FOCUS

MENU

SELECT
LAMPSTATUSPOWER

ON/STAND BY SOURCE
AUTO ADJ.

E
N

T
E

R

EXIT

STATUS

LAMP 

POWER

SELECT

MENU

ENTER EXITLAMP

STATUS

POWER

ON/STAND BY AUTO ADJ.SOURCE

MENU

UP

MAGNIFY PAGE

OFF

POWER

ON

PIC-MUTE

DOWN

POWER POWER POWER

STATUS

LAMP

STATUS

LAMP

STATUS

LAMP

Standby Blinking Power On

Steady orange light Blinking green
light

Steady green
light

(→ page 55)

This section describes how to turn on the projector and to project a picture onto the screen.

� Turning on the Projector

NOTE:
• The projector has two power switches: a main power switch and a POWER (ON/STAND BY) button (POWER ON and OFF on the

remote control).
• When plugging in or unplugging the supplied power cable, make sure that the main power switch is pushed to the off (�)

position. Failure to do so may cause damage to the projector.

1. To turn on the main power to the projector, press the
Main Power switch to the on position ( I ).

The POWER indicator will light orange.
See the Power Indicator section.(→ page 55)

2. Remove the lens cap

3. Press the POWER (ON/STAND BY) button on the
projector cabinet or the POWER ON button on the
remote control for 1 second.

The POWER indicator will turn to green and the
projector will become ready to use.

After you turn on your projector, ensure that the
computer or video source is turned on and that your
lens cap is removed.

NOTE: When no signal is available, a blue screen is displayed at
the factory default.
When the projector displays a blue, black, or logo screen, the
projector will automatically switch to the Eco mode.
The projector will return to the Normal mode once a signal is
connected.

NOTE: If you turn on the projector immediately after the lamp is
turned off or when the temperature is high, the fans run without
displaying an image for some time and then the projector will
display the image.

CAUTION:

The projector cannot be turned off for 60 seconds after the
lamp is turned on and while the POWER indicator is blinking
green. Doing so could cause premature lamp failure.
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3. Projecting an Image (Basic Operation)

Note on Startup screen (Menu Language Select screen)
When you first turn on the projector, you will get the Startup menu. This menu gives you the opportunity to select one
of the 8 menu languages.

To select a menu language, follow these steps:

1. Use the SELECT � or � button to select one of the 8
languages from the menu.

2. Press the ENTER button to execute the selection.

After this has been done, you can proceed to the menu op-
eration.
If you want, you can select the menu language later.
(→ [Language] on page 39 and 44)

NOTE: Immediately after turning on the projector, screen flicker may occur. This is normal. Wait 3 to 5 minutes until the lamp
lighting is stabilized.

When the Lamp mode is set to Eco, the LAMP indicator will light green.

If one of the following things happens, the projector will not turn on.

• If the internal temperature of the projector is too high, the projector detects abnormal high temperature. In this
condition the projector will not turn on to protect the internal system. If this happens, wait for the projector's internal
components to cool down.

• When the lamp reaches its end of usable life, the projector will not turn on. If this happens, replace the lamp.

• If the lamp fails to light, and if the STATUS indicator flashes on and off in a cycle of six times, wait a full minute and
then turn on the power.
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3. Projecting an Image (Basic Operation)
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� Selecting a Source
Selecting the computer or video source

NOTE: Turn on the computer or video source equipment connected to the projector.

Selecting from Source List
Press and quickly release the SOURCE button on the projector cabinet
to display the Source list. Each time the SOURCE button is pressed, the
input source will change as follows: “Computer 1”, “Computer 2 (Digital /
Analog)” (VT695/VT595 only), ”Computer 2” (VT491 only), ”Video” (VCR
or laser disc player), “S-Video”, To display the selected source,  allow 1
second to elapse.

Detecting the Signal Automatically
Press and hold the SOURCE button for a minimum of 2 seconds, the
projector will search for the next available input source. Each time you
press and hold the SOURCE button for a minimum of 2 seconds, the
input source will change as follows:

VT695/VT595
Computer1 → Computer2 (Digital) → Computer2 (Analog) → Video →
S-Video →  Computer1 → ...

VT491
Computer1 → Computer2 → Video → S-Video →  Computer1 → ...

VT590/VT59/VT49
Computer → Video → S-Video →  Computer → ...

TIP:
If no input signal is present, the input will be skipped.

Using the Remote Control
Press any one of the COMPUTER 1/2, VIDEO, S-VIDEO buttons.

NOTE: the COMPUTER 2 button is not available on the VT590, VT59 and VT49.

TIP: The COMPUTER 2 button on the remote control toggles the Computer 2 source
between [Computer 2 (Digital)] and [Computer 2 (Analog)] on the VT695 and VT595.

Selecting Default Source
You can set a source as the default source so that it will be displayed
each time the projector is turned on.
1. Select [Setup] → [Options] → [Default Source Select] from the

menu.

The [Default Source Select] screen will be displayed.

2. Select a source as the default source, and press the ENTER
button.

3. Press the EXIT button a few times to close the menu.

4. Restart the projector.

The source you selected in step 2 will be projected.

(→ page 47)



23

3. Projecting an Image (Basic Operation)

� Adjusting the Picture Size and Position
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PUSH
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Adjustable Tilt Foot

Adjustable Tilt
Foot Button

Place your projector on a flat level surface and ensure that the projector is
square to the screen.

Lift the front edge of the projector to center the image vertically.
* If the projected image does not appear square to the screen then use the

Keystone feature for proper adjustment. (→ page 25)

Move the projector left to center the image horizontally on the screen.

Adjust the Tilt Foot
1. Lift the front edge of the projector.

CAUTION:

Do not try to touch the ventilation outlet during Tilt Foot adjustment as it can
become heated while the projector is turned on and during its cool down
period after it is turned off.

2. Push and hold the Adjustable Tilt Foot Button on the front of the
projector to extend the adjustable tilt foot.

3. Lower the front of the projector to the desired height.

4. Release the Adjustable Tilt Foot Button to lock the Adjustable tilt
foot.

There is approximately 10 degrees (up) of adjustment for the front of the
projector.

The rear foot height can be adjusted up to 0.4 inch/10 mm.

Rotate the rear foot to the desired height in order to square the image on
the projection surface, but the vertical distance from the bottom to the
desk or floor should be 0.4 inch /10mm to make the projector horizontal
on the flat surface.

NOTE: Rotating the rear foot too much may cause the foot to come out of the
projector.

CAUTION:

• Do not use the tilt-foot for purposes other than originally intended.
Misuses such as using the tilt foot to carry or hang (from the wall or ceiling)
the projector can cause damage to the projector.
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3. Projecting an Image (Basic Operation)
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Zoom
VT695/VT595/VT590/VT491/VT59

Use the ZOOM lever to adjust the image size on the screen.

VT49

Focus
Use the FOCUS ring to obtain the best focus.

VT695/VT595/VT590/VT491/VT59
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VT49

Use the Digital ZOOM button on the projector cabinet to
electronically enlarge or reduce the image size.

NOTE: Digital Zoom can result in a blurry image due to the
electronic zoom.
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� Correcting Keystone Distortion
Correcting Keystone Distortion
If the screen is tilted vertically, keystone distortion becomes large. Proceed with the following
steps to correct keystone distortion

NOTE: The Keystone correction can cause an image to be slightly blurred because the correction is made electronically.

NOTE: The Keystone correction range can be made narrower, depending on a signal or its aspect ratio selection.

Adjusting with buttons on the cabinet
1. Press the SELECT � or � button with no menus displayed

The keystone bar will be displayed.

2. Use the SELECT � or � to correct the keystone distortion.

The keystone bar will be closed after a period of time.

NOTE: When the menu is displayed, the above operation is not available. When the menu is displayed, press the MENU button to
close the menu and start the Keystone correction.
From the menu, select [Setup] → [General] → [Keystone]. The changes can be saved with [Keystone Save]. (→page 44)

Adjusting with the Remote Control
1. Press the MENU button.

The menu will be displayed.
2. Press the SELECT � button to select [Setup] and press the ENTER button.

3. Press the SELECT � button to select [Keystone].

4. Press the SELECT � or � button.

Adjust so that the image is rectangular.

 

5. Press the MENU button.
The menu will be closed.

NOTE: The Keystone correction can cause an image to be slightly blurred because the correction is made electronically.

TIP: The changes can be saved with [Keystone Save]. (→page 44)

3. Projecting an Image (Basic Operation)
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Adjusting with the Auto Keystone Function (VT695 and VT595 only)
The Auto Keystone correction feature will correct the vertical distortion of a projected image on the screen. No special
operation required. Just put the projector on a flat surface.

TIP: Even when the menu setting for [Auto Keystone] is turned on, [Keystone] can be adjusted manually.

To turn on [Auto Keystone], proceed the following steps.
1. Press the MENU button

The menu will be displayed.
2. Press the SELECT � button to select [Setup] and press the ENTER button.

The [General] tab will be highlighted.
3. Press the SELECT � button.

The [Auto Keystone] will be highlighted.

4. Press the SELECT � or � button to select [On].

5. Press the MENU button.
The menu will be closed.

NOTE:
• Vertical distortions between offset angles of +/- 30 degrees can be corrected.
• The Auto Keystone correction will take effect in 2 seconds after changing the projection angle during projection.
• The left and right (horizontal) keystone correction is not available.
Place the projector so that the lens surface is parallel to the screen.
The rear feet of the projector can be adjusted to level the projector.

NOTE:
• Auto and Manual Keystone correction angle could be less than 30 degrees depending on the signal and/or aspect ratios.
• Using keystone correction can cause the image to be slightly blurred because the correction is made electronically.

NOTE:
• When the menu is displayed, the Keystone Correction operation is not available by using the buttons on the projector cabinet.

When the menu is displayed, press the EXIT button to close the menu and then perform the Keystone correction.
• From the menu, select [Setup] → [General] → [Keystone]. The changes can be saved with [Keystone Save].

(→page 44)

TIP: If you have one of the following conditions, the projector’s Auto Keystone may not be performed correctly.
• The screen is tilted
• The room temperature is too high or too low
• The optical zoom is maximized or minimized

3. Projecting an Image (Basic Operation)
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3. Projecting an Image (Basic Operation)

� Optimizing RGB Picture Automatically
Adjusting the Image Using Auto Adjust
Optimizing an RGB image automatically.
Press the AUTO ADJ. button to optimize an RGB image automatically.
This adjustment may be necessary when you connect your computer for the first time.

[Poor picture]

[Normal picture]
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NOTE:
Some signals may take time to display or may not be displayed correctly.
• VT695/VT595: The Auto Adjust function does not work for component, video, and DVI digital signals.
• VT590/VT491/VT59/VT49: The Auto Adjust function does not work for component and video signals.
• If the Auto Adjust operation cannot optimize the RGB signal, try to adjust Horizontal/Vertical Position, Clock and Phase

manually. (→page 43)

� Turning Up or Down Volume

Sound level from the speaker can be adjusted.

TIP: When no menus appear, the SELECT � and � buttons on the projector cabinet work as a volume control.
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� Turning off the Projector
To turn off the projector:

3. Projecting an Image (Basic Operation)
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1. First, press the POWER (ON/STAND BY) button on
the projector cabinet or the POWER OFF button on
the remote control. The [Power Off / Are you sure?]
message will appear.

2. Secondly, press the ENTER button or press the
POWER (ON/STAND BY) or the POWER OFF button
again.

The power indicator will glow orange. After the
projector turns off, the cooling fans keep operating
for 30 seconds (Cool-down time).

Immediately after turning on the projector and
displaying an image, you cannot turn off the
projector for 60 seconds.

3. Finally, turn off the Main Power switch. The power
indicator will go out.

TIP: The main power of the projector can be turned off by pressing
the main power switch or by unplugging the power cable even
during the cool down period after the projector is turned off.

NOTE: Do not turn off the main power within 10 seconds of making
adjustment or setting changes and closing the menu.
Doing so can cause loss of adjustments and settings.

Power On Fan running Standby

Steady green light Blinking
orange light

Steady orange
light
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CAUTION:

Parts of the projector will become heated during operation. Use caution when picking up the projector immediately
after it has been operating.

CAUTION:

• The projector cannot be turned off for 60 seconds after the lamp is turned on and while the POWER indicator is
blinking green. Doing so could cause premature lamp failure.

• Do not turn off the AC power by pressing the main power switch or by unplugging the power cable when the
projector is powered on. Doing so can cause damage to the projector.
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� After Use
Preparation: Make sure that the projector is turned off.

1. Unplug the power cable.

2. Disconnect any other cables.

3. Retract adjustable tilt feet if extended.

4. Cover the lens with the lens cap.

5. Put the projector and accessories in the supplied soft case.
Place the projector in the soft case with the lens facing upward as shown below. This is to prevent the lens from
damage.

3. Projecting an Image (Basic Operation)

NOTE: When placing the projector in the soft case, retract the tilt feet and the rear feet. Failure to do so may case damage to the
projector.

CAUTION:

Use caution when putting the projector in the soft case immediately after the projector has been operating. The
projector cabinet is hot.
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	 Turning off the Image and Sound
Press the PIC-MUTE button to turn off the image and sound for a short
period of time. Press again to restore the image and sound.

NOTE:
Sound from the AUDIO OUT jack (Stereo mini) on the VT695/VT595/VT491 can
be turned off.


 Freezing a Picture
Press the FREEZE button to freeze a picture. Press again to resume
motion.

� Enlarging a Picture
You can enlarge the picture up to four times.

NOTE: The maximum magnification may be less than four times depending on
the signal.

To do so:

1. Press the MAGNIFY (+) button to magnify the picture.

To move the magnified image, use the SELECT �,�,� or
�button.

2. Press the MAGNIFY (-) button to return the image to the
original size.

4. Convenient Features
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� Changing Lamp Mode
This feature enables you to select two brightness modes of the lamp:
Normal and Eco modes. The lamp life can be extended by using the Eco mode.

To change to the [Eco] mode, do the following:
1. Press the LAMP MODE button on the remote control to display [Lamp Mode] screen.

2. Use the SELECT � or � button to select [Eco] mode.

3. Press the ENTER button.
To change from [Eco] to [Normal], Go back to Step 2 and select [Normal]. Repeat Step 3.

NOTE:
• The Lamp Mode can be changed by using the menu.

Select [Setup] → [General] → [Lamp Mode].
• The lamp life remaining and lamp hours used can be checked in [Usage Time]. Select [Information] →[Usage Time].
• If the projector is overheated in Normal mode, there may be a case where the Lamp mode automatically changes to Eco mode

to protect the projector. When the projector is in Eco mode, the picture brightness decreases. When the projector comes back
to normal temperature, the Lamp mode returns to Normal mode.
Thermometer symbol [  ] indicates the lamp mode is automatically set to Eco mode because the internal temperature is too
high.

� Preventing the Unauthorized Use of the Projector
 To enable the Security function:
1. Press the MENU button.

The menu will be displayed.
2. Use the SELECT � or � button to select [Setup] and press the ENTER button.

3. Use the SELECT � or � button to select [Installation].

4. Use the SELECT � or � button to select  [Security] and press the SELECT � button.

Lamp Mode

Normal Mode

Eco Mode

Description

This is the default setting (100%
Brightness).

Select this mode to increase the
lamp life (approx. 80% Brightness).
*approx. 75% Brightness: VT695

Status of LAMP indicator

Off

Steady Green light

4. Convenient Features

Example of menu for
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POWER

STATUS

LAMP
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4. Convenient Features

5. Use the SELECT � or � button to select [On] and press the ENTER button.

The [Security Keyword] screen will be displayed.
6. Type in a combination of the four SELECT buttons  ���� and press the ENTER button.

NOTE: A keyword must be 4 to 10  digits in length. Please make a note of your keyword.

The [Confirm Keyword] screen will be displayed.

NOTE:
Do not forget your keyword. However, if you forget your keyword, NEC or your dealer will provide you with your Release
Code upon proof of ownership. See more information at the end of this section. (→page 33)

7. Type in the same combination of SELECT button ����  and press the ENTER button.

The confirmation screen will be displayed.
8. Select [Yes] and press the ENTER button.

The Security function has been enabled.
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4. Convenient Features

To turn on the projector when Security is enabled:
1. Press the Main Power Switch to the On position (I).

2. Press and hold the POWER ON or the ON/STAND BY button for a minimum of 1 second.
The projector will be turned on and display a message to the effect that the projector is security-protected.

3. Press the MENU button.

The Security Keyword screen will be displayed.
4. Enter your keyword in the Security Keyword screen and press the ENTER button.

You can view the projected image.

NOTE: The security disable mode is maintained until the main power is turned off (by setting the main power switch to "O" or
unplugging the power cord).

To disable the Security function:
1. Press the MENU button.

The menu will be displayed.
2. Use the SELECT � or � button to select [Setup] and press the ENTER button.

3. Use the SELECT � or � button to select [Installation].

4. Use the SELECT � or � button to select [Security] and press the SELECT � button.

5. Use the SELECT � or � button to select [Off] and press the ENTER button.

The keyword confirmation screen will be displayed.

6. Type in your keyword and press the ENTER button.
When the correct keyword is entered, the Security function will be disabled.

NOTE:
• If you forget your keyword, contact your dealer. Your dealer will provide you with your keyword in exchange for your request

code. Your request code is displayed in the Keyword Confirmation screen. In this example [NB52-YGK8-2VD6-K585-JNE6-
EYA8] is a request code.

• The [Security] setting cannot be cancelled by using the [Reset] of the menu.
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4. Convenient Features

� Using the Optional Remote Mouse Receiver (NP01MR)

The optional remote mouse receiver enables you to operate your computer’s mouse functions from the remote control.
It is a great convenience for clicking through your computer-generated presentations.

Connecting the remote mouse receiver to your computer
If you wish to use the remote mouse function, connect the mouse receiver and computer.
The mouse receiver can be connected directly to the computer’s USB port (type A).

NOTE: Depending on the type of connection or OS installed on your computer, you may have to restart your computer or change
your computer settings.

When operating a computer via the remote mouse receiver

When connecting using the USB terminal
For PC, the mouse receiver can only be used with a Windows 98/Me/XP*, Windows 2000 or Mac OS X 10.0.0 or later
operating system.

* NOTE: In SP1 or older version of Windows XP, if the mouse cursor will not move correctly, do the following:
Clear the Enhance pointer precision check box underneath the mouse speed slider in the Mouse Properties dialog box [Pointer
Options tab].

NOTE: Wait at least 5 seconds after disconnecting the mouse receiver before reconnecting it and vice versa. The computer may
not identify the mouse receiver if it is repeatedly connected and disconnected in rapid intervals.

Remote mouse receiver

Computer

To USB port of PC or Macintosh

30˚

30˚

Remote sensor on the
remote mouse receiver

7m/22 feet
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Operating your computer’s mouse from the remote control
You can operate your computer's mouse from the remote control.

PAGE UP/DOWN Button: scrolls the viewing area of the window or to move to the previous or next slide in PowerPoint
on your computer.

SELECT���� Buttons: moves the mouse cursor on your computer.

MOUSE L-CLICK Button: works as the mouse left button.

MOUSE R-CLICK Button: works as the mouse right button.

About Drag Mode:
By pressing the MOUSE L-CLICK or R-CLICK button for 2 or 3 seconds then releasing, the drag mode is set and the
drag operation can be performed simply by pressing the SELECT ���� button. To drop the item, press the MOUSE
L-CLICK (or R-CLICK) button. To cancel it, press the MOUSE R-CLICK (or L-CLICK) button.

NOTE: When you operate the computer using the SELECT ��� or � button with the menu displayed, both the menu and the
mouse pointer will be affected. Close the menu and perform the mouse operation.

TIP: You can change the Pointer speed on the Mouse Properties dialog box on the Windows. For more information, see the user
documentation or online help supplied with your computer.

4. Convenient Features
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5. Using On-Screen Menu
� Using the Menus

NOTE: The on-screen menu may not be displayed correctly while interlaced motion video image is projected.

1. Press the MENU button on the remote control or projector cabinet to display the Menu.

2. Press the SELECT � or � button on the remote control or the projector cabinet to highlight the menu for
the item you want to adjust or set.

3. Press the SELECT � button or the ENTER button on the remote control or the projector cabinet to select
a submenu or item.
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5. Using On-Screen Menu
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4. Use the SELECT � or � button on the remote control or the
projector cabinet to select the item you want to adjust or set.

5. Adjusting the level of a selected item or selecting an item.

For Adjusting items (Slide bar)
Slide bar .......... Indicates settings or the direction of adjustment.
• Use the SELECT �� buttons to adjust the item.

For Selecting items (Solid triangle)

Solid triangle .... Indicates further choices are available. A highlighted
triangle indicates the item is active.

(1) Use the SELECT � button to select the item.
(2) Use the SELECT �� buttons to highlight the item you want to set.
(3) Press the ENTER button. The selected item will be displayed.

For Selecting items (Radio button)
Radio button .... Use this round button to select an option in a dialog

box.
• Use the SELECT �� buttons to select the item.
Changes are stored until you adjust it again.
Press the EXIT button to return to the previous screen.

6. Repeat steps 2-5 to adjust an additional item, or press the
MENU button to close the menu.
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5. Using On-Screen Menu


 Menu Elements

Highlight

Title Slide bar

Off Timer remaining
time

Source

Radio button

Solid triangle

Check mark

Tab

Thermometer symbol

Key Lock symbol

Menu windows or dialog boxes typically have the following elements:

Title .......................................... Indicates the menu title.
Highlight ................................... Indicates the selected menu or item.
Source ...................................... Indicates the currently selected source.
Off Timer remaining time ......... Indicates the remaining countdown time when the Off Timer is preset.
Solid triangle ............................ Indicates further choices are available. A highlighted triangle indicates the item is active.
Tab ........................................... Indicates a group of features in a dialog box. Selecting on any tab brings its page to the front.
Radio button ............................ Use this round button to select an option in a dialog box.
Check mark .............................. Indicates the item is selected.
Slide bar ................................... Indicates settings or the direction of adjustment.
Key Lock symbol ...................... Indicates the Control Panel Lock is enabled.
Thermometer symbol ............... Indicates the lamp mode is forcibly set to Eco mode because the internal temperature is too

high.
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� List of Menu Items

5. Using On-Screen Menu

Picture Default Item

Preset * 1 to 6
Detail Settings General

Reference High-Bright, Presentation, Video, Movie, Graphic, sRGB
Gamma Correction Dynamic, Natural, Black Detail
Color Temperature 6500, 7800, 8500, 9300

White Balance
Contrast RGB, Brightness RGB

Contrast
Brightness
Sharpness
Color
Hue
Reset

Image Options Default Item

Aspect Ratio * Normal, Wide Zoom, Cinema, Native
Cinema Position
Horizontal *
Vertical *
Clock *
Phase *
Video Filter * Off, Less, More

Setup Default Item

General Auto Keystone (VT695/VT595 only) Off Off, On
Keystone
Keystone Save Off Off, On
Wall Color Off Off, Blackboard, Blackboard(Gray), Light yellow,

Light green, Light blue, Sky blue, Light rose, Pink
Lamp Mode Normal Normal, Eco
Language English English, Deutsch, Français, Italiano, Español,

Português, Nederlands, Svenska, Norsk, Suomi,
, Magyar, Polski, Türkçe, ,

, ,   , , , Dansk
Beep On Off, On

Installation Orientation Desktop Front Desktop Front, Ceiling Rear, Desktop Rear,
Ceiling Front

Communication Speed 19200 4800, 9600, 19200
Control Panel Lock Off Off, On
Security Off Off, On
Menu Color Select Color Color, Monochrome
Menu Display Time Auto 45 sec Manual, Auto 5 sec, Auto 15sec, Auto 45 sec
Background Blue Blue, Black, Logo

Options Off Timer Off Off, 0:30, 1:00, 2:00, 4:00, 8:00, 12:00, 16:00
Auto Adjust Normal Off, Normal, Fine
Auto Start Off Off, On
Power Management Off Off, 0:05, 0:10, 0:20, 0:30
Fan Mode Auto Auto, High
Default Source Select Last Last, Auto, Computer, Computer 1, Computer

2(Digital), Computer 2 (Analog), Video, S-Video
• Computer: VT590/VT59/VT49 only
• Computer 1, Computer 2 (Digital), Computer 2

(Analog): VT695/VT595 only
• Computer 1, Computer 2 : VT491 only

Some menu items are not available depending on the input source.
Resettable

Yes

Yes
Yes
Yes

Yes
Yes
Yes
Yes
Yes

Resettable

Yes
Yes
Yes
Yes
Yes
Yes
Yes

Resettable

Yes
Yes
Yes
Yes

Yes
–

Yes
Yes

–
Yes
–

Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes

* The asterisk (*) indicates that the default setting varies depending on the signal.
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Information Item

Usage Time Lamp Life Remaining
Lamp Hours Used
Filter Hours Used

Source Source index
Horizontal Frequency
Vertical Frequency
Signal Type RGB, Component, Video, S-Video, HDTV, Digital
Video Type NTSC, NTSC3.58, NTSC4.43, PAL, PAL-M, PAL-N, PAL60, SECAM
Sync Type Separate Sync, Composite Sync, Sync on Green, Sync on Video
Sync Polarity
Scan Type Interlace, Non-interlace

Version Product
Serial Number
Firmware
Data

Reset Item

Current Signal
All Data
Clear Lamp Hours
Clear Filter Hours

Signal Select
Computer 1 RGB/ RGB/Component, RGB, Component
(VT695/VT595/VT491) Component
Computer 2 (Analog) RGB/ RGB/Component, RGB, Component
(VT695/VT595) Component
Computer 2 (VT491) RGB/ RGB/Component, RGB, Component

Component
Computer RGB/ RGB/Component, RGB, Component
(VT590/VT59/VT49) Component
Video Auto Auto, NTSC3.58, NTSC4.43, PAL, PAL-M,

PAL-N, PAL60, SECAM
S-Video Auto Auto, NTSC3.58, NTSC4.43, PAL, PAL-M,

PAL-N, PAL60, SECAM
Deinterlace On Off, On

Yes

Yes

Yes

Yes

Yes

Yes

Yes
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� Menu Descriptions & Functions [Picture]
Preset

    

When selecting user adjustable [Preset], the submenu will be displayed.
You can customize each gamma or color. To do so, first select [Preset] and press the ENTER button, then proceed
using the following steps.

Detail Settings

   

Selecting Reference Setting [Reference]
This option allows you to adjust neutral tint for yellow, cyan or magenta. There are six factory presets optimized for
various types of images, you can set user adjustable settings.

High-Bright ............ Recommended for the use in a brightly lit room.
Presentation .......... Recommended for making a presentation using a PowerPoint file.
Video ..................... Recommended for standard video such as a TV program.
Movie .................... Recommended for film based video such as a movie (DVD or HDTV).
Graphic .................. Recommended for viewing accurate colors in graphics.
sRGB ..................... Standard color values.

Selecting Gamma Correction Mode [Gamma Correction]
Each mode is recommended for:

Dynamic ................ Creates a high-contrast picture.
Natural .................. Natural reproduction of the picture.
Black Detail ........... Emphasizes detail in dark areas of the picture.

Adjusting Color Temperature [Color Temperature]
This option allows you to select the color temperature of your choice.

NOTE: When [High-Bright] or [Presentation] is selected in [Reference], [Color Temperature] is not available.
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Normal

Standard
4:3 Aspect

When 16:9 is selected from
the source (i.e. DVD player),
the following selections will
display:

Normal

16:9 image displayed
in 4:3 mode

Wide Zoom Cinema Native

Left and right
stretched

Left and right
stretched

Wide Zoom Cinema

Left and right
stretched

Left and right stretched to
display the true aspect

When 4:3 is selected from
the source (i.e. DVD player),
the following selections will
display:

Adjusting White Balance [White Balance]
This allows you to adjust the white balance. Contrast for each color (RGB) to adjust the white level of the screen;
Brightness for each color (RGB) is used to adjust the black level of the screen.

Adjusting Contrast, Brightness, Sharpness, Color and Hue
You can adjust contrast, brightness, sharpness, color and hue.

Contrast ................ Adjusts the intensity of the image according to the incoming signal (White level of the image).
Brightness ............. Adjusts the brightness level or the black level of the image.
Sharpness ............. Controls the detail of the image for Video (not valid for RGB).
Color ..................... Increases or decreases the color saturation level (not valid for RGB).
Hue ........................ Varies the color level from +/- green to +/-blue. The red level is used as reference. This adjustment is only

valid for Video and Component inputs (not valid for RGB).

Reset
The settings and adjustments for [Picture] will be returned to the factory settings with the exception of the following;
Preset numbers and [Reference] within the [Preset] screen.
The settings and adjustments under [Detail Settings] within the [Preset] screen that are not currently selected will not be reset.


 Menu Descriptions & Functions [Image Options]

Selecting Aspect Ratio [Aspect Ratio]
Aspect Ratio allows you to select the best Aspect mode to display your source image.
You can also display the Aspect Ratio menu by pressing the ASPECT button on the remote control.

Native (RGB only): Turns off the scaling feature. The projector displays the current image in its true resolution.
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NOTE:
• When you are displaying an RGB image with a higher resolution than the projector’s native resolution, the image will be

displayed in the projector’s native resolution. In this case [Native] is not available from the menu.
Only when displaying an RGB image with a lower resolution than the projector's native resolution, will the image be able to be
displayed in its true resolution [Native].

• When Computer 2 (Digital) is selected, some options of Aspect Ratio are not available depending on the signal.
• You can adjust the image position for Cinema aspect. See [Cinema Position] for setting the image position.

Copyright
Please note that using this projector for the purpose of commercial gain or the attraction of public attention in a venue such as a
coffee shop or hotel and employing compression or expansion of the screen image with a [Aspect Ratio] setting may raise concern
about the infringement of copyrights which are protected by copyright law.

Adjusting the Vertical Position of Image [Cinema Position] (for Cinema only)
This feature adjusts the vertical position of the image when viewing video with Cinema aspect ratio selected.
When [Cinema] is selected in [Aspect Ratio], the image is displayed with black borders on the top and bottom.
You can adjust the vertical position from the top to the bottom of the black area.

NOTE: This option is available only when [Cinema] is selected in [Aspect Ratio].

Adjusting Horizontal/Vertical Position, Clock and Phase [Horizontal/Vertical/Clock/Phase]
(available for RGB signal only)
You can adjust the image manually for position and stability; [Horizontal], [Vertical], [Clock] and [Phase].

[Horizontal/Vertical]
Adjusts the image location horizontally and vertically.

[Clock]
Use this item to fine tune the computer image or to remove any vertical banding that might appear. This function
adjusts the clock frequencies that eliminate the horizontal banding in the image. This adjustment may be neces-
sary when you connect your computer for the first time.

[Phase]
Use this item to adjust the clock phase or to reduce video noise, dot interference or cross talk. (This is evident
when part of your image appears to be shimmering.)
Use [Phase] only after the [Clock] is complete.

NOTE:
A projected image may not be displayed correctly during adjustment of [Clock] or [Phase]. This is normal.

NOTE: The [Horizontal] and [Vertical] options can be adjusted for component signals.

Selecting Video Filter Level [Video Filter] (not available for Digital RGB, Video and S-Video)
Select one of the three levels for reducing video noise: Off, Less or More.

Off ......................... The low-pass filter is turned off.
Less ...................... The low-pass filter is applied partially.
More ...................... The low-pass filter is applied fully.

NOTE:
• Selecting [Off] will give best image quality by way of higher bandwidth. Selecting [Less] will soften the image and selecting

[More] will soften the image more.
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� Menu Descriptions & Functions [Setup]
[General]

  

Enabling Auto Keystone [Auto Keystone] (VT695/VT595 only)
This feature allows the projector to detect its tilt and correct vertical distortion automatically.
To turn on the Auto Keystone feature, select [On].

Correcting Vertical Keystone Distortion Manually [Keystone]
You can correct vertical distortion manually.

Saving Vertical Keystone Correction [Keystone Save]
This option enables you to save your current keystone settings.

Off ......................... Does not save current keystone correction settings
On ......................... Saves current keystone correction settings

Saving your change once affects all sources. The changes are saved when the projector is off.

NOTE: When [Auto Keystone] is set to [On], [Keystone Save] is not available. Next time you turn on the power, the Auto Keystone
function will work and the data stored with [Keystone Save] will be invalid.

Selecting Wall Color Correction Mode [Wall Color]
This function allows for quick adaptive color correction in applications where the screen material is not white.
The following nine options are available: Off, Blackboard, Blackboard (Gray), Light yellow, Light green, Light blue, Sky
blue, Light rose and Pink.

Selecting Lamp Mode [Lamp Mode]
This feature enables you to select two brightness modes of the lamp: Normal and Eco modes. The lamp life can be
extended by using the Eco mode.

Normal Mode ........ This is the Default setting (100% Brightness).
Eco Mode .............. Select this mode to increase the lamp life (approx. 80% Brightness).

* approx. 75% Brightness: VT695

Selecting Menu Language [Language]
You can choose one of 21 languages for the on-screen menu.

Enabling Key Sound and Error Sound [Beep]
This feature turns on or off the keypad sound or alarm when a button on the cabinet and the remote control is pressed
or an error occurs.

VT695/VT595 VT590/VT491/VT59/VT49

Computer: VT590/VT59/VT49
Computer 1: VT491
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[Installation]

Selecting Projector Orientation [Orientation]
This sets your image for your type of projection application. The options are:
desktop front projection, ceiling rear projection, desktop rear projection, and ceiling front projection.

Selecting Communication Speed [Communication Speed]
This feature sets the baud rate of the PC Control port (Mini DIN 8 Pin). It supports data rates from 4800 to 19200 bps.
The default is 19200 bps.
Select the appropriate baud rate for your equipment to be connected (depending on the equipment, a lower baud rate
may be recommended for long cable runs).
Your selected communication speed will not be affected even when [Reset] is done from the menu.

Disabling the Cabinet Buttons [Control Panel Lock]
This option turns on or off the Key Lock function for cabinet buttons.

NOTE:
• The Control Panel Lock setting will not affect the remote control or PC Control Functions.
• When the cabinet buttons are disabled, pressing and holding the EXIT button on the projector cabinet for about 10 seconds will

change the setting to enable.
• The Key Lock icon will be displayed at the bottom right of the menu when Control Panel Lock is enabled.

Desktop front Ceiling rear

Desktop rear Ceiling front
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Enabling Security [Security]
This feature turns on or off the Security function.
Unless the correct keyword is entered, the projector cannot project an image. (→page 31)

Selecting Menu Color [Menu Color Select]
You can choose between two color modes for menu color: color and monochrome.

Selecting Menu Display Time [Menu Display Time]
This option allows you to select how long the projector waits after the last touch of a button to turn off the menu.
The preset choices are [Manual], [Auto 5 sec], [Auto 15 sec], and [Auto 45 sec].

Selecting a Color for Background [Background]
Use this feature to display a blue, black or logo when no signal is available.

[Options]

Setting Off Timer [Off Timer]
You can use the Off Timer feature to turn off the projector automatically at a preset time.
Eight preset times can be selected: Off, 0:30, 1:00, 2:00, 4:00, 8:00, 12:00 and 16:00.

Setting Auto Adjust [Auto Adjust]
This feature sets the Auto Adjust mode so that the RGB image can be automatically or manually adjusted for noise
and stability. You can automatically make adjustment in two ways: Normal and Fine

Off ......................... The RGB image will not be automatically adjusted.
You can manually optimize the RGB image.

Normal .................. Default setting. The RGB image will be automatically adjusted. Normally select this option.
Fine ....................... Select this option if fine adjustment is needed. It takes more time to switch to the source than when [Normal]

is selected.

Enabling Auto Start [Auto Start]
Turns the projector on automatically when the power cable is inserted into an active power outlet. This eliminates the
need to always use the POWER button on the remote control or projector cabinet.
To use the Auto Start function, you must first press the main power switch to the position “On” (I) before plugging the
power cable.

Enabling Power Management [Power Management]
When this option is selected you can enable the projector to automatically turn off (at the selected time: 5 min., 10
min., 20 min., 30 min.) if there is no signal received by any input.

5. Using On-Screen Menu
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Enabling Fan Speed Mode [Fan Mode]
This option allows you to select two modes for fan speed: Auto mode and High speed mode.

Auto ...................... The built-in fans automatically run at a variable speed according to the internal temperature.
High ...................... The built-in fans run at a fixed high speed.

When you wish to cool down the temperature inside the projector quickly, select [High].

NOTE: It is recommended that you select High speed mode if you continue to use the projector for consecutive days.

Selecting Default Source [Default Source Select]
You can set the projector to default to any one of its inputs each time the projector is turned on.

Last ....................... Sets the projector to default to the previous or last active input each time the projector is turned on.
Auto ...................... Searches for an active source in order of Computer 1 → Computer 2 (Digital) → Computer 2 (Analog) →

Video → S-Video → Computer 1 and displays the first found source.
NOTE The VT491 will search for an active source in order of Computer 1 → Computer 2 → Video → S-Video
→ Computer 1 and displays the first found source.
NOTE The VT590, VT59 and VT49 will search for an active source in order of Computer → Video → S-Video
→ Computer and displays the first found source.

Computer 1 ........... Displays the RGB source from the COMPUTER 1 IN connector every time the projector is started up. (VT695/
VT595/VT491 only)

Computer 2 (Digital) ... Displays the DVI digital source from the COMPUTER 2 IN connector every time the projector is started up.
(VT695/VT595 only)

Computer 2 (Analog) .. Displays the RGB source from the COMPUTER 2 IN connector every time the projector is started up. (VT695/
VT595 only)

Computer 2 ........... Displays the RGB source from the COMPUTER 2 IN connector every time the projector is started up. (VT491 only)
Computer .............. Displays the RGB source from the COMPUTER IN connector every time the projector is started up. (VT590/

VT59/VT49 only)
Video ..................... Displays the Video source from the VIDEO IN connector every time the projector is started up.
S-Video ................. Displays the Video source from the S-VIDEO IN connector every time the projector is started up.

Selecting Signal Format [Signal Select]
[Computer]*1,[Computer 1],[Computer 2 (Analog)],[Computer 2]*2

Allows you to choose [Computer]*1, [Computer 1], [Computer 2 (Analog)], or [Computer 2]*2 for an RGB source such as
a computer, or [Component] for a component video source such as a DVD player. Normally select [RGB/Component]
and the projector automatically detects a component signal. However there may be some component signals that the
projector is unable to detect. If this is the case, select [Component].
*1 [Computer]: VT590, VT59 and VT49 only
*2 [Computer 2]: VT491 only

[Video & S-Video System Select]
This feature enables you to select composite video standards automatically or manually.
Normally select [Auto] and the projector will automatically detect the video standard.
In the case where the projector has difficulty detecting the video standard, select the appropriate video standard from
the menu.
This must be done for Video and S-Video respectively.

Enabling the deinterlace [Deinterlace]
Turns on or off the deinterlace function for a telecine signal.

On ......................... Default standard setting.
Off ......................... Select this option if there is any jitter or artifacts in video.

NOTE: This feature is not available for RGB, 480p, 576p and HDTV signals.
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� Menu Descriptions & Functions [Information]
Displays the status of the current signal and lamp usage. This item has three pages. The information included is as
follows:

[Usage Time]

[Lamp Life Remaining] (%)*
[Lamp Hours Used] (H)
[Filter Hours Used] (H)
* The progress indicator shows the percentage of remaining bulb life.

The value informs you of the amount of lamp usage. When the remaining lamp time reaches 0, the Remaining
Lamp Time bar indicator changes from 0% to 100 Hours and starts counting down.

If the remaining lamp time reaches 0 hours, the projector will not turn on regardless of whether the lamp mode
is set to Normal or Eco.

[Source]

[Source Index] [Horizontal Frequency]
[Vertical Frequency] [Signal Type]
[Video Type] [Sync Type]
[Sync Polarity] [Scan Type]

Model

VT695/VT595/

VT590/VT491

VT59/VT49

Lamp life(H)

Normal Eco

2000 3000

3000 4000

Replacement lamp

VT85LP

VT80LP
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[Version]

[Product] [Firmware] Version
[Serial Number] [Data] Version

� Menu Descriptions & Functions [Reset]

Returning to Factory Default [Reset]
The Factory Default feature allows you to change adjustments and settings to the factory preset for a (all) source (s)
except the following:

[Current Signal]
Resets the adjustments for the current signal to the factory preset levels.
The items that can be reset are: [Preset], [Contrast], [Brightness], [Color], [Hue], [Sharpness], [Aspect Ratio],
[Horizontal], [Vertical], [Clock], [Phase] and [Video Filter].

[All Data]
Reset all the adjustments and settings for all the signals to the factory preset.
All items can be reset except [Language], [Communication Speed], [Security], [Lamp Life Remaining], [Lamp
Hours Used] and [Filter Hours Used].
To reset the lamp usage time, see “Clearing Lamp Hour Meter [Clear Lamp Hours] below”.

Clearing Lamp Hour Meter [Clear Lamp Hours]
Resets the lamp clock back to zero. Selecting this option displays submenu for a confirmation. Select [Yes] and press the
ENTER button.

NOTE: Elapsed time of the lamp use will not be affected even when [Reset] is done from the menu.

NOTE: The projector will turn off and go into standby mode after 2100* hours (up to 3100* hours in Eco mode) of service. If this
happens, press the HELP button on the remote control for ten seconds to reset the lamp clock back to zero. Do this only after
replacing the lamp. * VT59 and VT49: 3100 hours (up to 4100 hours in Eco mode).

Clearing the Filter Usage Hours [Clear Filter Hours]
Resets the filter usage back to zero. Selecting this option displays submenu for a confirmation. Select [Yes] and press the
ENTER button.

NOTE: Elapsed time of the filter use will not be affected even when [Reset] is done from the menu.
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MENU
SELECT

LAMP STATUS POWER

ON/STAND BY

SOURCE

AUTO ADJ.

E
N

T
E

R

EXIT

FOCUS

ZOOM

VT695/VT595/VT590/VT491

VT59/VT49

This section describes the simple maintenance procedures you should follow to clean the filters and replace the lamp.

� Cleaning or Replacing the Filters
The air-filter sponge keeps dust and dirt from getting inside the projector and should be cleaned after every 100 hours
of operation (more often in dusty conditions). If the filter is dirty or clogged, your projector may overheat.

CAUTION

• Turn off the projector, turn off the main power switch and unplug the projector before replacing the filters.

• Only clean the outside of the filter cover with a vacuum cleaner.

• Do not attempt to operate the projector without the filter cover.

To clean the air-filter:
Vacuum the filter-through the filter cover.

To replace the filter (sponge):
1. Remove the filter cover by pushing down on the catch of the cover until you feel it detach.

NOTE: The VT695/VT595/VT590/VT491 have two filters; the VT59 and VT49 have one filter only.

Catch

2. Gently peel off the filter (sponge) and replace it with the new one.
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3. Reinstall the new filter cover.

4. Clear the filter hours used.

To reset the filter usage time, from the menu, select [Reset] → [Clear Filter Hours].
(→page 49 for resetting the filter usage time.)

NOTE: Do not wash the filter with soap and water. Soap and water will damage the filter membrane. Before replacing the filter,
remove dust and dirt from the projector cabinet. Keep out dust and dirt during filter replacement.

NOTE: When you replace the lamp, it is also wise to replace the filter. The filter comes in the same package with your replacement
lamp.


 Cleaning the Cabinet and the Lens
1. Turn off the projector before cleaning.

2. Clean the cabinet periodically with a damp cloth. If heavily soiled, use a mild detergent. Never use
strong detergents or solvents such as alcohol or thinner.

3. Use a blower or lens paper to clean the lens, and be careful not to scratch or mar the lens.

FOCUS

MENU

SELECT
LAMPSTATUSPOWER

ON/STAND BY SOURCE
AUTO ADJ.

E
N

T
E

R

EXIT

ZOOM

MENU
SELECT

LAMP STATUS POWER

ON/STAND BY

SOURCE

AUTO ADJ.

E
N

T
E

R

EXIT

FOCUS

ZOOM
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� Replacing the Lamp
After your lamp has been operating for 2000*1 hours (up to 3000*1 hours in Eco mode) or longer, the LAMP indicator in
the cabinet will blink red and the message [The lamp has reached the end of its usable life. Please replace the
lamp.] *2 will appear. Even though the lamp may still be working, replace it at 2000*1 (up to 3000*1 hours in Eco mode)
hours to maintain optimal projector performance. After replacing the lamp, be sure to clear the lamp hour meter.
(→ page 49)

CAUTION

• DO NOT TOUCH THE LAMP immediately after it has been used. It will be extremely hot. Turn the projector off,
wait 30 seconds, turn off the main power switch and then disconnect the power cable. Allow at least one hour
for the lamp to cool before handling.

• DO NOT REMOVE ANY SCREWS except two lamp case screws. You could receive an electric shock.

• Do not break the glass on the lamp housing.

Keep finger prints off the glass surface on the lamp housing. Leaving finger prints on the glass surface might
cause an unwanted shadow and poor picture quality.

• The projector will turn off and go into standby mode after 2100*1 (up to 3100*1 hours in Eco mode) hours of service.
If this happens, be sure to replace the lamp. If you continue to use the lamp after 2000*1 hours (up to 3000*1 hours
in Eco mode) of use, the lamp bulb may shatter, and pieces of glass may be scattered in the lamp case. Do not
touch them as the pieces of glass may cause injury. If this happens, contact your NEC dealer for lamp
replacement.

*1 NOTE: Lamp life for VT59/VT49 is 3000 hours in Normal mode and 4000 hours in Eco mode.
The projector will turn off and go into standby mode after 3100 (up to 4100 hours in Eco mode) hours of service.

*2 NOTE: This message will be displayed under the following conditions:
• for one minute after the projector has been powered on
• when the POWER ON/STAND BY button on the projector cabinet or the POWER OFF button on the remote control is pressed

To turn off the message, press any button on the projector cabinet or the remote control.

To replace the lamp:
 Optional lamp and tools needed for replacement:

• Replacement lamp VT85LP (VT695/VT595/VT590/VT491) or VT80LP (VT59/VT49)

1. Place the projector on a soft cloth and turn it over to access the lamp cover on the bottom.

6. Maintenance
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3. Remove the lamp housing.

(1)Loosen the two screws securing the lamp housing until the phillips screwdriver goes into a freewheeling
condition. The two screws are not removable.

(2)Remove the lamp housing by holding it.

6. Maintenance

NOTE: There is an interlock on this case to prevent the risk of electrical shock. Do not attempt to circumvent this interlock.

Interlock

2. Remove the lamp cover.

(1)Press firmly and slide the lamp cover by 1 cm (0.4”)

• Do not force to pull the lamp cover

(2)Push to release two catches on both sides and slide the lamp cover off.

1

3

2
1
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6. Connect the supplied power cable, turn on the Main Power switch and turn on the projector.

7. Finally, select the menu → [Reset] → [Clear Lamp Hours] to reset the lamp usage hours.

NOTE: When the lamp exceeds 2100* hours (up to 3100* hours in Eco mode) of service, the projector cannot turn on and the
menu is not displayed.
If this happens, press the HELP button on the remote control for ten seconds to reset the lamp clock back to zero.
When the lamp time clock is reset to zero, the LAMP indicator goes out.
* VT59 and VT49: 3100 hours (up to 4100 hours in Eco mode).

5. Reattach the lamp cover.

(1)Place the lamp cover, aligning it with the guiding line.

(2)Slide the lamp cover back until it snaps into place.

4. Install a new lamp housing.

(1)Insert a new lamp housing until the lamp housing is plugged into the socket.

CAUTION
Do not use a lamp other than the NEC replacement lamp VT85LP (VT695/VT595/VT590/VT491) or VT80LP (VT59/VT49).
Order this from your NEC dealer.

(2)Secure it in place with the two screws.

Be sure to tighten the screws.
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Indicator Condition Projector Condition Note

Off
Blinking light

Steady light

Green

Orange

Green
Orange

0.5 sec On,
0.5 sec Off
2.5 sec On,
0.5 sec Off
0.5 sec On,
0.5 sec Off

The main power is off
The projector is getting ready to turn on.

Off Timer is enabled.

The projector is cooling down.

The projector is turned on.
The projector is in Standby.

–
Wait for a moment.

–

Wait for a moment.

–
–

Status Indicator

Indicator Condition Projector Condition Note

Off
Blinking light

Steady light

Red

Green

Orange

1 cycle (0.5 sec On,
2.5 sec Off)

2 cycle (0.5 sec On,
0.5 sec Off)

4 cycle (0.5 sec On,
0.5 sec Off)

6 cycle (0.5 sec On,
0.5 sec Off)

Normal
Lamp cover error or lamp housing error

Temperature error

Fan error

Lamp error

Re-firing the lamp (The projector is cool-
ing down.)
Cabinet button is locked

–
Replace the lamp cover or lamp
housing correctly.
The projector is overheated. Move
the projector to a cooler location.
Fans will not work correctly.

Lamp fails to light. Wait a full
minute and then turn on again.
The projector is re-firing.
Wait for a moment.
You have pressed cabinet button
when Cabinet Button is locked.

Lamp Indicator

Indicator Condition Projector Condition Note

Off
Blinking light

Steady light

Normal
Lamp has reached its end of life. Lamp
replacement message will be displayed.
Lamp has been used beyond its limit. The
projector will not turn on until the lamp is
replaced.
Lamp mode is set to Eco mode

Red

Red

Green

–
Replace the lamp.

Replace the lamp.

–

� Troubleshooting
This section helps you resolve problems you may encounter while setting up or using the projector.

Indicator Messages

Power Indicator

Over-Temperature Protection
If the temperature inside the projector rises too high, the over-temperature protector will automatically turn off the
lamp with the STATUS indicator blinking (2-cycle On and Off.)
Should this happen, do the following:
• Unplug the power cable after the cooling fans stop.
• Move the projector to a cooler location if the room where you are presenting is particularly too warm.
• Clean the ventilation holes if they are clogged with dust.
• Wait about 60 minutes until the inside of the projector becomes cool enough.
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Common Problems & Solutions (→ "Power/Status/Lamp Indicator" on page 55.)

Does not turn on

Will turn off

No picture

Picture suddenly
becomes dark

Color tone or hue is
unusual

Image isn’t square to
the screen

Picture is blurred

Image is scrolling
vertically, horizontally
or both

Remote control does
not work

Indicator is lit or
blinking

Cross color in RGB
mode

• Check that the power cable is plugged in and that the power button on the projector cabinet or the remote
control is on. (→ pages 19 and 20)

• Ensure that the lamp cover is installed correctly. (→ page 54)
• Check to see if the projector has overheated. If there is insufficient ventilation around the projector or if the

room where you are presenting is particularly warm, move the projector to a cooler location.
• Check to see if the lamp usage exceeds 2100* hours (up to 3100* hours : Eco mode). If so, replace the lamp.

After replacing the lamp, reset the lamp hours used. (→ page 49)
* VT59 and VT49: 3100 hours (up to 4100 hours in Eco mode)

• The lamp may fail to light. Wait a full minute and then turn on the power again.

• Ensure that the Power Management or Off Timer is off. (→ page 46)

• Use the COMPUTER, the VIDEO or the S-VIDEO button on the remote control to select your source (Computer,
Video or S-Video). (→ page 22) If there is still no picture, press the button again.

• Ensure your cables are connected properly.
• Use menus to adjust the brightness and contrast. (→ page 42)
• Remove the lens cap.
• Reset the settings or adjustments to factory preset levels using the [Reset] in the Menu. (→ page 49)
• Enter your registered keyword if the Security function is enabled. (→ page 31)
• Be sure to connect the projector and notebook PC while the projector is in standby mode and before turning on

the power to the notebook PC.
In most cases the output signal from the notebook PC is not turned on unless connected to the projector
before being powered up.
* If the screen goes blank while using your remote control, it may be the result of the computer's screen-

saver or power management software.
• See also the next page.

• When one of the following happens, the Lamp mode automatically changes from Normal to Eco.
* When there are no signals → To return to the Normal mode, select another available source.
* When the room where you' re presenting is particularly warm → Move the projector to a cooler location, or

set [Fan Mode] to [High].

• Check if an appropriate color is selected in [Wall Color]. If so, select an appropriate option. (→ page 44)
• Adjust [Hue] in [Picture]. (→ page 42)

• Reposition the projector to improve its angle to the screen. (→ page 23)
• Use the Keystone correction function to correct the trapezoid distortion. (→ page 25)

• Adjust the focus. (→ page 24)
• Reposition the projector to improve its angle to the screen. (→ page 23)
• Ensure that the distance between the projector and screen is within the adjustment range of the lens.

(→ page 11 for VT695, page 11 for VT595/VT590/VT491/VT59 and 12 for VT49)
• Condensation may form on the lens if the projector is cold, brought into a warm place and is then turned on.

Should this happen, let the projector stand until there is no condensation on the lens.

• Use the COMPUTER, the VIDEO or the S-VIDEO button on the remote control to select your source (Computer,
Video or S-Video). (→ page 22)

• Adjust the computer image manually with the Horizontal/Vertical in the [Image Options]. (→ page 43)

• Install new batteries.(→ page 8)
• Make sure there are no obstacles between you and the projector.
• Stand within 22 feet (7 m) of the projector. (→ page 8)

• See the POWER/STATUS/LAMP Indicator. (→ page 55)

• Press the AUTO ADJ. button on the projector cabinet or the remote control. (→ page 27)
• Adjust the computer image manually with Clock/Phase in [Image Options] in the menu. (→ page 43)

Problem Check These Items

For more information contact your dealer.
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If there is no picture, or the picture is not displayed correctly.

• Power on process for the projector and the PC.

Be sure to connect the projector and notebook PC while the projector is in standby mode and before turning on
the power to the notebook PC.

In most cases the output signal from the notebook PC is not turned on unless connected to the projector before
being powered up.

NOTE: You can check the horizontal frequency of the current signal in the projector’s menu under Information.  If it reads
“0kHz”, this means there is no signal being output from the computer. (→ page 48 or go to next step)

• Enabling the computer’s external display.

Displaying an image on the notebook PC’s screen does not necessarily mean it outputs a signal to the projec-
tor.  When using a PC compatible laptop, a combination of function keys will enable/disable the external display.
Usually, the combination of the ‘Fn” key along with one of the 12 function keys gets the external display to come
on or off.  For example, NEC laptops use Fn + F3, while Dell laptops use Fn + F8 key combinations to toggle
through external display selections.

• Non-standard signal output from the computer

If the output signal from a notebook PC is not an industry standard, the projected image may not be displayed
correctly. Should this happen, deactivate the notebook PC’s LCD screen when the projector display is in use.
Each notebook PC has a different way of deactivate/reactivate the local LCD screens as described in the
previous step. Refer to your computer’s documentation for detailed information.

• Image displayed is incorrect when using a Macintosh

When using a Macintosh with the projector, set the DIPswitch of the Mac adapter (not supplied with the projec-
tor) according to your resolution. After setting, restart your Macintosh for the changes to take affect.

For setting display modes other than those supported by your Macintosh and the projector, changing the DIP
switch on a Mac adapter may bounce an image slightly or may display nothing. Should this happen, set the DIP
switch to the 13” fixed mode and then restart your Macintosh. After that, restore the DIP switches to a
displayable mode and then restart the Macintosh again.

NOTE: A Video Adapter cable manufactured by Apple Computer is needed for a PowerBook which does not have a mini D-Sub
15-pin connector.

• Mirroring on a PowerBook

* When using the projector with a Macintosh PowerBook, output may not be set to 1024 x 768 unless “mirror-
ing” is off on your PowerBook. Refer to owner’s manual supplied with your Macintosh computer for mirroring.

• Folders or icons are hidden on the Macintosh screen

Folders or icons may not be seen on the screen. Should this happen, select [View] → [Arrange] from the Apple
menu and arrange icons.
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� Specifications

This section provides technical information about the VT695/VT595/VT590/VT491/VT59/VT49 projector's performance.

Model Number VT695/VT595/VT590/VT491/VT59/VT49

Optical
LCD Panel VT695: 0.63" p-Si TFT active-matrix with Micro Lens Array

VT595/VT590/VT491/VT59/VT49:0.6" p-Si TFT active-matrix with Micro
Lens Array

Resolution VT695/VT595/VT590/VT59: 1024 � 768 pixels* native, up to UXGA with
Advanced AccuBlend
VT491/VT49: 800 � 600 pixels* native, up to UXGA with Advanced
AccuBlend

Lens VT695/VT595/VT590/VT491/VT59: Manual zoom and manual focus
F1.7 - 2.0   f=18.9 - 22.7 mm
VT49: Digital zoom and manual focus
F1.7     f=22.4 mm

Lamp VT695: 200 W DC lamp (150W Eco mode)
VT595/VT590/VT491: 190 W DC lamp (150W Eco mode)
VT59/VT49: 150 W DC lamp (120W Eco mode)

Light Output** VT695: 2500 lumens (approx. 75% in Eco mode)
VT595/VT590/VT491: 2000 lumens (approx. 80% in Eco mode)
VT59/VT49: 1600 lumens (approx. 80% in Eco mode)

Contrast Ratio 600: 1 (full white: full black)
Image Size (Diagonal) VT695/VT595/VT590/VT491/VT59: 21 - 300 inches / 0.5 - 7.6 m

VT49: 25 - 300 inches / 0.6 - 7.6 m
Projection Distance VT695: 28" - 424" / 0,7 - 10,7 m

VT595/VT590/VT491/VT59: 29" - 438" / 0,7 - 11,1 m
VT49: 35" - 434" / 0,9 - 11,0 m

Projection Angle VT695/VT595/VT590/VT491/VT59: Tele: 8.3° - 8.6°/ Wide: 9.9° - 10.3°
VT49: 8.4° - 8.7°

Keystone Correction +/- 30° Vertical (Auto Keystone on VT695/VT595 only)

Electrical
Inputs VT695/VT595: 1 RGB/Component (D-Sub 15 Pin), 1 RGB (Digital/Analog) (DVI-

I 29 Pin, HDCP*** supported), 1 S-Video (DIN 4 Pin), 1 Video (RCA), 1 (L/R)
RCA Audio, 1 Stereo Mini Audio, 1 PC Control (DIN 8 Pin)
VT491: 2 RGB/Component (D-Sub 15 Pin), 1 S-Video (DIN 4 Pin), 1 Video
(RCA), 1 (L/R) RCA Audio, 1 Stereo Mini Audio, 1 PC Control (DIN 8 Pin)
VT590/VT59/VT49: 1 RGB/Component (D-Sub 15 Pin), 1 S-Video (DIN
4 Pin), 1 Video (RCA), 1 (L/R) RCA Audio, 1 PC Control (DIN 8 Pin)

Outputs 1 RGB (D-Sub 15 Pin), 1 Stereo Mini Audio (VT695/VT595/VT491 only)
Video Compatibility NTSC, NTSC4.43, PAL, PAL-60, PAL-N, PAL-M, SECAM,

DTV: 480i, 480p, 720p, 1080i (60Hz)
576i, 576p, 1080i (50Hz)

DVD: Progressive (50/60Hz)
Scan Rate Horizontal: 15 kHz to 100 kHz (RGB: 24 kHz or over)

Vertical: 50 Hz to 120 Hz
Video Bandwidth RGB: 80 MHz (-3dB)
Color Reproduction 16.7 million colors simultaneously, Full color
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Horizontal Resolution NTSC / NTSC4.43/PAL/PAL-M/PAL-N/PAL60: 540 TV lines
SECAM: 300 TV lines
RGB: VT695/VT595/VT590/VT59: 1024 dots (H)�768 dots (V),
VT491/VT49: 800 dots (H)�600 dots (V)

External Control RS232, IR
Sync Compatibility Separate Sync / Composite Sync / Sync on Green / Sync on Video
Built-in Speaker VT695/VT595: 5W (monaural)

VT590/VT491/VT59/VT49: 1W (monaural)
Power Requirement 100 - 240V AC, 50 / 60 Hz
Input Current VT695/VT595/VT590/VT491: 3.1 - 1.3A

VT59/VT49: 2.4 - 1.0A
Power Consumption VT695: 9W in Standby mode /

285W in Lamp Normal mode / 220W in Lamp Eco mode
VT595: 9W in Standby mode /
270W in Lamp Normal mode / 220W in Lamp Eco mode
VT590/VT491: 9W in Standby mode /
255W in Lamp Normal mode / 205W in Lamp Eco mode
VT59/VT49: 9W in Standby mode /
205W in Lamp Normal mode / 170W in Lamp Eco mode

Mechanical
Installation Orientation Desktop/Front, Desktop/Rear, Ceiling/Front, Ceiling/Rear
Dimensions 12.2" (W)�4.4" (H)�10.2" (D)

309mm (W)�112mm (H)�258mm (D)
(not including protrusions)

Weight VT695/VT595: approx. 6.6 lbs / 3.0 kg
VT590/VT491: approx. 6.4 lbs / 2.9 kg
VT59/VT49: approx. 6.2 lbs / 2.8 kg

Environmental Considerations Operational Temperatures : 41° to 104°F (5° to 40°C),
(Eco mode selected automatically at 95°F to 104°F/35°C to 40°C)
20% to 80% humidity (non-condensing)
Storage Temperatures : 14° to 122°F (-10° to 50°C),
20% to 80% humidity (non-condensing)

* Effective pixels are more than 99.99%.
** This is the light output value (lumens) when the [Preset] mode is set to [High-Bright]. If any other mode

is selected as the [Preset] mode, the light output value may drop slightly.
*** What is HDCP/HDCP technology?

HDCP is an acronym for High-bandwidth Digital Content Protection. High bandwidth Digital Content
Protection (HDCP) is a system for preventing illegal copying of video data sent over a Digital Visual
Interface (DVI).
If you are unable to view material via the DVI input, this does not necessarily mean the VT695/VT595
projector is not functioning properly. With the implementation of HDCP, there may be cases in which
certain content is protected with HDCP and might not be displayed due to the decision/intention of the
HDCP community (Digital Content Protection, LLC).
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Regulations
VT695/VT595/VT590/VT491/VT49: For United States:

UL Approved (UL 60950 - 1)
Meets FCC Class B requirements

For Canada:
UL Approved (CSA 60950 - 1)
Meets DOC Canada Class B requirements

For Australia/New Zealand:
Meets AS/NZS CISPR.22 Class B

For Europe:
Meets EMC Directive (EN55022, EN55024, EN61000-3-2, EN61000-3-3)
Meets Low Voltage Directive (EN60950 - 1, TÜV GS Approved)

VT59: Meets EMC Directive (EN55022, EN55024, EN61000-3-2, EN61000-3-3)
Meets Low Voltage Directive (EN60950-1, TÜV GS Approved)

For additional information visit:
US : http://www.necdisplay.com/
Europe : http://www.nec-display-solutions.com/
Global : http://www.nec-pj.com/
For information on our optional accessories, visit our website or see our brochure.

The specifications are subject to change without notice.

7. Appendix
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� Cabinet Dimensions
Although the appearance is slightly different, the VT695, VT595, VT590, VT491, VT59 and VT49 are the same in
dimensions.
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Mini D-Sub 15 Pin Connector
� Pin Assignments of D-Sub COMPUTER Input Connector

Signal Level
Video signal : 0.7Vp-p (Analog)
Sync signal : TTL level

51 42 3
10

11 12 13 14 15
6 97 8

7. Appendix

* Only COMPUTER 1 input connector supported on VT695/VT595/VT491.

Pin No. RGB Signal (Analog) YCbCr Signal

1 Red Cr
2 Green or Sync on Green Y
3 Blue Cb
4 Ground
5 Ground
6 Red Ground Cr Ground
7 Green Ground Y Ground
8 Blue Ground Cb Ground
9 No Connection

10 Sync Signal Ground
11 No Connection
12 Bi-directional DATA (SDA)*
13 Horizontal Sync or Composite Sync
14 Vertical Sync
15 Data Clock*
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� Compatible Input Signal List
Horizontal: 15KHz to 100KHz (RGB: 24KHz or over)
Vertical: 50Hz to 120Hz

Signal Resolution Frequency H. Refresh Rate
( Dots ) ( kHz ) ( Hz )

NTSC – 15.73 59.94
PAL – 15.63 50.00
PAL60 – 15.73 60.00
SECAM – 15.63 50.00

D VESA 640 � 480 31.47 59.94
D IBM 640 � 480 31.48 59.95
D MAC 640 � 480 35.00 66.67
D VESA 640 � 480 37.86 72.81
D VESA 640 � 480 37.50 75.00
D IBM 640 � 480 39.38 75.00
D VESA 640 � 480 43.27 85.01
D IBM 720 � 350 31.47 70.08
D IBM 720 � 350 39.44 87.85
D IBM 720 � 400 39.44 87.85
D VESA 800 � 600 35.16 56.25
D VESA 800 � 600 37.88 60.32
D VESA 800 � 600 48.08 72.19
D VESA 800 � 600 46.88 75.00
D VESA 800 � 600 53.67 85.06

@ D MAC 832 � 624 49.72 74.55
@ D VESA 1024 � 768 48.36 60.00
@ D VESA 1024 � 768 56.48 70.07
@ D MAC 1024 � 768 60.24 74.93
@ D VESA 1024 � 768 60.02 75.03
@ D VESA 1024 � 768 68.68 85.00
@ D # VESA 1152 � 864 67.50 75.00
@ D # MAC 1152 � 870 68.68 75.06
@ D # VESA 1280 � 960 60.00 60.00
@ # 1280 � 960 75.00 75.00
@ # 1280 � 960 85.94 85.00
@ D # VESA 1280 � 1024 63.98 60.02
@ D # MAC 1280 � 1024 64.30 60.38
@ # MAC 1280 � 1024 69.87 65.18
@ # VESA 1280 � 1024 79.98 75.02
@ # VESA 1280 � 1024 91.15 85.02
@ # VESA 1400 � 1050 63.98 60.02
@ # VESA 1600 � 1200 75.00 60.00
@ # VESA 1600 � 1200 81.25 65.00
@ # VESA 1600 � 1200 87.50 70.00
@ # VESA 1600 � 1200 93.75 75.00

SDTV(576i) – 15.63 50.00 Interlace
D SDTV(576p) – 31.25 50.00 Progressive

@ D # HDTV (1080i) 1920 � 1080 33.75 60.00 Interlace
@ D # HDTV (1080i) 1920 � 1080 28.13 50.00 Interlace
@ D # HDTV (720p) 1280 � 720 45.00 60.00 Progressive

D SDTV (480p) 720 � 480 31.47 59.94 Progressive
DVD YCbCr – 15.73 59.94 Interlaced
DVD YCbCr – 15.63 50.00 Interlaced

# : Images in above flagged with # are compressed with Advanced AccuBlend on VT695/VT595/
VT590/VT59.

D : Images in above flagged with “D” are supported by the DVI digital signals on VT695/VT595.
@ : Images in above flagged with @ are compressed with Advanced AccuBlend on VT491/VT49.

NOTE: Some composite sync signals may not be displayed correctly.

Signals other than those specified in the table above may not be displayed correctly. If this should happen, change
the refresh rate or resolution on your PC. Refer to Display Properties help section of your PC for procedures.

UXGA (1600�1200) is supported for separate sync signal only.
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Cable Connection
Communication Protocol

Baud rate ........................................ 19200 bps
Data length ..................................... 8 bits
Parity .............................................. No parity
Stop bit .......................................... One bit
X on/off .......................................... None
Communications procedure ........... Full duplex

NOTE: Depending on the equipment, a lower baud rate may be recommended for long cable runs.

PC Control Codes (VT590/VT491/VT59/VT49)

Function Code Data
POWER ON 02H 00H 00H 00H 00H 02H
POWER OFF 02H 01H 00H 00H 00H 03H
INPUT SELECT COMPUTER 1* 02H 03H 00H 00H 02H 01H 01H 09H
INPUT SELECT COMPUTER 2* 02H 03H 00H 00H 02H 01H 02H 0AH
INPUT SELECT COMPUTER 02H 03H 00H 00H 02H 01H 01H 09H
INPUT SELECT VIDEO 02H 03H 00H 00H 02H 01H 06H 0EH
INPUT SELECT S-VIDEO 02H 03H 00H 00H 02H 01H 0BH 13H
PICTURE MUTE ON 02H 10H 00H 00H 00H 12H
PICTURE MUTE OFF 02H 11H 00H 00H 00H 13H
SOUND MUTE ON 02H 12H 00H 00H 00H 14H
SOUND MUTE OFF 02H 13H 00H 00H 00H 15H
* VT491 only

NOTE: Contact your local dealer for a full list of the PC Control Codes if needed.

� PC Control Codes and Cable Connection
PC Control Codes (VT695/VT595)

Function Code Data
POWER ON 02H 00H 00H 00H 00H 02H
POWER OFF 02H 01H 00H 00H 00H 03H
INPUT SELECT COMPUTER 1 02H 03H 00H 00H 02H 01H 01H 09H
INPUT SELECT COMPUTER 2 (Digital) 02H 03H 00H 00H 02H 01H 1AH 22H
INPUT SELECT COMPUTER 2 (Analog) 02H 03H 00H 00H 02H 01H 02H 0AH
INPUT SELECT VIDEO 02H 03H 00H 00H 02H 01H 06H 0EH
INPUT SELECT S-VIDEO 02H 03H 00H 00H 02H 01H 0BH 13H
PICTURE MUTE ON 02H 10H 00H 00H 00H 12H
PICTURE MUTE OFF 02H 11H 00H 00H 00H 13H
SOUND MUTE ON 02H 12H 00H 00H 00H 14H
SOUND MUTE OFF 02H 13H 00H 00H 00H 15H
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1 2

3 4 5

6 7 8

To RxD of PC

PC Control Connector (DIN-8P)

To TxD of PC To GND of PC

NOTE: Pins 2, 3, 5, 6 and 8 are used inside the projector.
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No image is displayed from your PC or video equipment to the
projector.

Still no image even though you connect the projector to the PC
first, then start the PC.
Enabling your notebook PC’s signal output to the projector.
• A combination of function keys will enable/disable the ex-

ternal display. Usually, the combination of the “Fn” key along
with one of the 12 function keys turns the external display
on or off.

No image (blue or black background, no display).
Still no image even though you press the AUTO ADJUST but-
ton.
Still no image even though you carry out [Reset] in the
projector’s menu.
Signal cable's plug is fully inserted into the input connector
A message appears on the screen.
( _____________________________________________ )
The source connected to the projector is active and available.
Still no image even though you adjust the brightness and/or
the contrast.
Input source's resolution and frequency are supported by the
projector.

7. Appendix

� Troubleshooting Check List
Before contacting your dealer or service personnel, check the following list to be sure repairs are needed also by
referring to the “Troubleshooting” section in your user’s manual. This checklist below will help us solve your problem
more efficiently.
* Print this page and the next page for your check.

Frequency of occurrence  � always   � sometimes (How often?_____________________)    � other (__________________)
Power

No power (POWER indicator does not light green)   See also “Sta-
tus Indicator (STATUS)”.

Power cable's plug is fully inserted into the wall outlet.
Main power switch is pressed to the ON position.
Lamp cover is installed correctly .
Lamp Hours Used (lamp operation hours) was cleared after
lamp replacement.
No power even though you press and hold the POWER button
for 1 second.

Shut down during operation.
Power cable's plug is fully inserted into the wall outlet.
Lamp cover is installed correctly .
Power Management is turned off (only models with the Power
Management function).
Off Timer is turned off (only models with the Off Timer function ).

Video and Audio

Image is too dark.
Remains unchanged even though you adjust the brightness
and/or the contrast.

Image is distorted.
Image appears to be trapezoidal (unchanged even though you
carry out the [Keystone] adjustment).

Parts of the image are lost.
Still unchanged even though you press the AUTO ADJUST but-
ton.
Still unchanged even though you carry out [Reset] in the
projector’s menu.

Image is shifted in the vertical or horizontal direction.
Horizontal and vertical positions are correctly adjusted on a
computer signal.
Input source's resolution and frequency are supported by the
projector.
Some pixels are lost.

Image is flickering.
Still unchanged even though you press the AUTO ADJUST but-
ton.
Still unchanged even though you carry out [Reset] in the
projector’s menu.
Image shows flickering or color drift on a computer signal.

Image appears blurry or out of focus.
Still unchanged even though you checked the signal’s resolu-
tion on PC and changed it to projector’s native resolution.
Still unchanged even though you adjusted the focus.

No sound.
Audio cable is correctly connected to the audio input of the
projector.
Still unchanged even though you adjusted the volume level.
AUDIO OUT is connected to your audio equipment (only mod-
els with the AUDIO OUT connector).

Other
Remote control does not work.

No obstacles between the sensor of the projector and the re-
mote control.
Projector is placed near a fluorescent light that can disturb the
infrared remote controls.
Batteries are new and are not reversed in installation.

Buttons on the projector cabinet do not work ( only models with
the Key Lock function).

Control Panel Lock is not turned on or is disabled in the menu.
Still unchanged even though you press and hold the EXIT but-
ton for a minimum of 10 seconds.
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In the space below please describe your problem in detail.

Information on application and environment where your projector is used

Projector

Model number:
Serial No.:
Date of purchase:
Lamp operating time (hours):
Lamp Mode: � Normal  � Eco
Information on input signal:

Horizontal synch frequency [          ] kHz
Vertical synch frequency [          ] Hz
Synch polarity H � (+)  � (–)

V � (+)  � (–)
Synch type � Separate  � Composite

� Sync on Green
STATUS Indicator:

Steady light � Orange  � Green
Flashing light [          ] cycles

Remote control model number:

Signal cable

NEC standard or other manufacturer’s cable?
Model number:                        Length:              inch/m

Distribution amplifier
Model number:

Switcher
Model number:

Adapter
Model number:

Projector PC

DVD player

Installation environment

Screen size: inch
Screen type: � White matte   � Beads  � Polarization

� Wide angle   � High contrast
 Throw distance: feet/inch/m
 Orientation: � Ceiling mount   � Desktop
Power outlet connection:

� Connected directly to wall outlet
� Connected to power cord extender or other (the num-

ber of connected equipment______________)
� Connected to a power cord reel or other (the number

of connected equipment______________)

Computer

Manufacturer:

Model number:

Notebook PC � / Desktop �

Native resolution:

Refresh rate:

Video adapter:

Other:

Video equipment

VCR, DVD player, Video camera, Video game or other

Manufacturer:

Model number:
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� TravelCare Guide
TravelCare - a service for international travelers
This product is eligible for "TravelCare", NEC's unique international war-
ranty.
Please note that TravelCare coverage differs in part from coverage un-
der the warranty included with the product.

Services offered with TravelCare
This warranty allows customers to receive service on their product at
the NEC and NEC-designated service stations in the countries listed
herein when temporarily traveling internationally for business or plea-
sure.
For details on services offered by the different service stations, please
refer to the "List of TravelCare Outlets" below.

1 Repair services
The product will be repaired and delivered within 10 business days,
not including shipping time.
During the term of warranty, the cost of maintenance parts, labor
costs for repairs and shipping costs within the service station's cov-
erage area are covered by the warranty.

2 Replacement product rental service
If the customer desires, he or she can rent a replacement product
while the original product is being repaired.
Fee: US$200 for 12 days
This fee must be paid at the local service station in cash or credit
card.
The US$200 rental fee is non-refundable even if the customer rents
it less than 12 days before returning.
The replacement product will be delivered within 3 business days.
If the customer did not return the replacement product within 12 days,
the customer will be charged the price of the unit.
If the customer returned the replacement product in a faulty or dam-
aged condition, the repair cost will be charged to the customer.
Note that this service is not offered in all countries and regions. Please
refer to the "List of TravelCare Outlets".
In addition, this replacement product rental service is not offered af-
ter the product's warranty has expired.

Term of warranty
1

a. Upon presentation of the warranty or receipt received upon pur-
chase:

Valid for the term indicated on the warranty or the normal term
of warranty for the country of purchase.

b. When only the product is brought in:

Valid for a period of within 14 months of the date of manufacture
indicated by the serial number attached to the product.

2 When a product whose term of warranty is expired is brought in:

Repairs will be offered for a fee. In this case the customer is not
eligible for the replacement product rental service.

3 In the following cases, repairs may be charged, even if the product's
warranty is still in effect:

1) If the term of warranty, model name, serial number and name of
the store of purchase are not indicated on the warranty or have
been altered.

2) Problems or damage caused by dropping or shocks during ship-
ment or movement by the customer or by improper handling by
the customers.

3) Problems or damage caused by improper usage or unwarrant-
able alterations or repairs by the customer.

4) Problems or damage caused by fire, salt damage, gas damage,
earthquakes, lightning damage, storm or flood damage or other
natural disasters or such external factors as dust, cigarette
smoke, abnormal voltage, etc.

5) Problems or damage caused by use in hot or humid places, in
vehicles, boats or ships, etc.

6) Problems or damage caused by expendable supplies or devices
connected to the product other than those designated by NEC.

7) Problems caused by natural consumption, wear or deterioration
of parts under normal usage conditions.

8) Problems or damage to lamps and other expendable supplies,
included parts or optional parts.

9) Other conditions stipulated in the warranty included with the prod-
uct also apply.

NOTE: The product can be used overseas with voltages indicated in the rating
label on the product by using a power cable suited for the standards and
power source voltage of the country in which the product is being used.

List of TravelCare Outlets
This list applies as of April 1, 2007.
For the most up-to-date information, please refer to the websites of the
service stations in the various countries on the List of TravelCare Outlets
or to the NEC website at http://www.nec-pj.com.

In Europe
NEC Europe Ltd. / European Technical Centre

Address: Unit G, Stafford Park 12, Telford TF3 3BJ, U.K.
Telephone: +44 1952 237000
Fax Line: +44 1952 237006
Email Address: AFR@uk.neceur.com
WEB Address: http://www.neceur.com

(Regions Covered)
EU: Austria*, Belgium*, Denmark*, Finland*, France*, Germany*,

Greece*, Ireland*, Italy*, Luxembourg*, The Netherlands*,
Portugal*, Spain*, Sweden* and the United Kingdom*

EEA: Norway*, Iceland and Liechtenstein

In North America
NEC Display Solutions of America, Inc.

Address: 500 Park Boulevard, Suite 1100 Itasca, Illinois
60143, U.S.A.

Telephone: +1 800 836 0655
Fax Line: +1 800 356 2415
Email Address: vsd.tech-support@necsam.com
WEB Address: http://www.necdisplay.com/

(Regions Covered)
U.S.A. *, Canada*

In Oceania
NEC Australia Pty., Ltd.

Address:
New South Wales;

184 Milperra Road, Reversby NSW 2212
Telephone: +61 2 9780 8688 Fax Line: +61 2 9780 8659

Victoria;
Unit 1/6 Garden Road, Clayton VIC 3168
Telephone: +61 3 8562 6245 Fax Line: +61 3 8562 6220

Newcastle;
120 Parry Street Newcastle West NSW 2300
Telephone: +61 2 4926 2466

Queensland;
Unit 4/305 Montague Road West End QLD 4101
Telephone: +61 7 3840 5858 Fax Line: +61 7 3840 5866

Goldcoast QLD;
Shop1 48 Ferry Road Southport QLD 4215
Telephone: +61 7 5591 3670

South Australia;
84A Richmond Road, Keswick 5035
Telephone: +61 8 8375 5707 Fax Line: +61 8 8375 5757

Western Australia;
45 Sarich Court Osborne Park WA 6017
Telephone: +61 8 9445 5901 Fax Line: +61 8 9445 5999
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Hyosung ITX Co., Ltd.
Address: 2nd Fl., Ire B/D. #2, 4Ga, Yangpyeng-Dong,

Youngdeungpo-Gu, Seoul, Korea 150-967
Telephone: +82 2 2163 4193
Fax Line: +82 2 2163 4196
Email Address: moneybear@hyosung.com

(Regions Covered)
South Korea

Lenso Communication Co., Ltd.
Address: 292 Lenso House 4, 1st Floor, Srinakarin Road,

Huamark, Bangkapi, Bangkok 10240, Thailand
Telephone: +66 2 375 2425
Fax Line: +66 2 375 2434
Email Address: pattara@lenso.com
WEB Address: http://www.lenso.com

(Regions Covered)
Thailand

ABBA Electronics L.L.C.
Address: Tariq Bin Ziyad Road, P.O.Box 327, Dubai, United

Arab Emirates
Telephone: +971 4 371800
Fax Line: +971 4 364283
Email Address: ABBA@emirates.net.ae

(Regions Covered)
United Arab Emirates

Samir Photographic Supplies
Address: P.O.Box 599, Jeddah 21421, Saudi Arabia
Telephone: +966 2 6828219
Fax Line: +966 2 6830820
Email Address: asif@samir-photo.com

Riyadh
Address: P.O.Box 5519, Riyadh 11432, Saudi Arabia
Telephone: +966 1 4645064
Fax Line: +966 1 4657912
Email Address: bhimji@samir-photo.com

Alkhobar
Address: P.O.Box 238, Alkhobar 31952, Saudi Arabia
Telephone: +966 3 8942674
Fax Line: +966 3 8948162
Email Address: chamsedin@samir-photo.com

(Regions Covered)
Saudi Arabia

NOTE: In countries designated with an asterisk(*), replacement product rental
service are offered.

WEB Address: http://www.nec.com.au

(Regions Covered)
Australia*, New Zealand

In Asia and Middle East
NEC Display Solutions, Ltd.

Address: 686-1, Nishioi, Oi-Machi, Ashigarakami-Gun,
Kanagawa 258-0017, Japan

Telephone: +81 465 85 2369
Fax Line: +81 465 85 2393
Email Address: support_pjweb@nevt.nec.co.jp
WEB Address: http://www.nec-pj.com

(Regions Covered)
Japan*

NEC Hong Kong Ltd.
Address: 25/F.,The Metropolis Tower, 10 Metropolis Drive,

Hunghom, Kowloon, Hong Kong
Telephone: +852 2369 0335
Fax Line: +852 2795 6618
Email Address: nechksc@nechk.nec.com.hk

esmond_au@nechk.nec.com.hk
WEB Address: http://www.nec.com.hk

(Regions Covered)
Hong Kong

NEC Taiwan Ltd.
Address: 7F, No.167, SEC.2, Nan King East Road, Taipei,

Taiwan, R.O.C.
Telephone: +886 2 8500 1714
Fax Line: +886 2 8500 1420
Email Address: chenguanfu@nec.com.tw
WEB Address: http://www.nec.com.tw

(Regions Covered)
Taiwan

NEC Solutions Asia Pacific Pte. Ltd
Address: 401 Commonwealth Drive, #07-02, Haw Par

Technocentre, Singapore 149598
Telephone: +65 6 273 8333
Fax Line: +65 6 274 2226
Email Address: tehgh@rsc.ap.nec.com.sg
WEB Address: http://www.nec.com.sg/ap

(Regions Covered)
Singapore

NEC Systems Integration Malaysia Sdn Bhd
Address: Ground Floor, Menara TA One, 22, Jalan P.

Ramlee, 50250 Kuala Lumpur, Malaysia
Telephone: +6 03 2178 3600 (ISDN)
Fax Line: +6 03 2178 3789
Email Address: necare@nsm.nec.co.jp
WEB Address: http://www.necarecenter.com

(Regions Covered)
Malaysia
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TO: NEC or NEC's Authorized Service Station:
FM:

(Company & Name with signature)

Dear Sir (s),

I would like to apply your TravelCare Service Program based on attached registration and qualification sheet and agree with your

following conditions, and also the Service fee will be charged to my credit card account, if I don't return the Loan units within the

specified period. I also confirm following information is correct.     Regards.

Application Sheet for TravelCare Service Program

P-1/    ,

Country,

product purchased :

User's Company Name :

User's Company Address :

Phone No., Fax No. :

User's Name :

User's Address :

Phone No., Fax No. :

Local Contact office :

Local Contact office Address :

Phone No., Fax No. :

User's Model Name :

Date of Purchase :

Serial No. on cabinet :

Problem of units per User :

Required Service : (1) Repair and Return (2) Loan unit

Requested period of Loan unit :

Payment method : (1) Credit Card (2) Travelers Cheque (3) Cash

In Case of Credit Card :

Card No. w/Valid Date :

Date:      /       /       ,
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5. Loan Service Charges and Conditions:
Upon acceptance of this NEC Projector, Customer agrees to assume
liability for this loan unit.

The current cost of use of this loan unit is US$200 for 12 calendar days.
If Customer does not return the unit within the 12 calendar days, Cus-
tomer will be charged the next highest cost up to and including the full
list price to Credit Cards, which price will be informed by NEC Autho-
rized Service Stations. Please see the attached listing of contacts for
each country to arrange for pickup of the loan unit.

If you return to their country of origin with the loan unit, you will be
charged additional freight to return the unit to the loaning country.

Thank you for your understanding of this program.

Condition of your TravelCare Service Program
Enduser is requested to understand following condition of TravelCare
Service Program and complete the necessary information on the appli-
cation sheet.

1. Service Options:
There are 3 types of [Service] available. Enduser has to understand
following condition and is required to fill in the Application Sheet.

1) Repair and Return:

The 'Faulty unit' is sent or collected from the customer. It is repaired
and returned within 10 days to the customer, excluding transport time.

There may have a case, repair and return can't be done by NEC
Authorized Service Station, because of shortage of spare parts due
to same model is not sold in the territory.

2) Repair and Return with Loan: (This service is limited to some Ser-
vice Stations)

This service is offered to the Enduser, who cannot wait until their unit
is repaired.

The customer can borrow a unit for US$200 up to 12 days. Customer
then sends in inoperable unit to nearest NEC Authorized Service
Station for service. In order to prevent collection problem, Enduser is
required to fill in Application Sheet.

Enduser needs to confirm the availability of the Service to NEC Au-
thorized Service Stations.

3) Loan Only:

For this service, NEC Authorized Service Station supplies the cus-
tomer with a loan unit for US$200 up to 12 days. Customer keeps the
inoperable unit and when customer returns home, customer arranges
to have the projector serviced in the home country.

2. Warranty Exclusions:
This program does not apply if the Projector's serial number has been
defaced, modified or removed.
If, in the judgement of NEC Authorized Service Station or its agent the
defects or failures result from any cause other than fair wear and tear or
NEC neglect, or fault including the following without limitation:

1) Accidents, transportation, neglect, misuse, abuse, water, dust, smoke
or default of or by the Customer its employees or agents or any third
party;

2) Failure or fluctuation of electrical power, electrical circuitry, air condi-
tioning, humidity control or other environmental conditions such as
use it in smoking area;

3) Any fault in the attachments or associated products or components
(whether or not supplied by NEC or its agents which do not form part
of the Product covered by this warranty);

4) Any act of God, fire, flood, war, act of violence or any similar occur-
rence;

5) Any attempt by any person other than any person authorized by NEC
to adjust, modify, repair, install or service the product.

6) Any Cross-border charges such as, duty, insurance, tax etc.

3. Charges for Warranty Exclusions and Out of Warranty Case:
In case faulty unit is under warranty exclusions case or under Out of
Warranty period, NEC Authorized Service Station will Inform estimation
of actual service cost to the Enduser with reason.

4. Dead on Arrival (DOA):
Enduser must take this issue up with their original supplier in the coun-
try of purchase.
NEC Authorized Service Station will repair the DOA unit as a Warranty
repair, but will not exchange DOA unit with new units.

Ver. 3  04/07
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